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How Stacker Works
In the process of creating a Stacker drive, Stacker Setup modifies your computer system configuration so 
Stacker can work with your operating system to handle the compressed data. Setup does all these things:
· Creates a directory if necessary, copies all the Stacker files to it, and adds the Stacker directory to 

your path (in AUTOEXEC.BAT).
· Defines the Stacker driver that compresses and decompresses data.
· Arranges to swap drive letters, if necessary.
· Inserts commands to load the device driver (into DBLSPACE.BIN or CONFIG.SYS).
· Defines a configuration file (STACKER.INI) that holds information for the device drivers.
· Inserts commands to handle Stacker device driver memory management (into CONFIG.SYS).
· Inserts command to enable AutoProtect (into AUTOEXEC.BAT).

For more information:
How Stacker works during Setup
How Stacker works after Setup
What is data compression?
Stacker in memory
Stacker configuration



During Setup
Stacker Setup works a bit differently depending on the status of your computer system. 
· If you haven't used compression before, you can choose Express to let Stacker Setup compress all 

your hard disks or Custom to let you choose one at a time.
· If you previously used DoubleSpace or a similar compression product, Stacker Setup converts any 

mounted compressed drives to Stacker's superior format. 
· If you compressed disks with an earlier version of Stacker for Windows & DOS, Stacker Setup 

updates those disks to the new storage format. You can choose a Quick or Full Update. If you choose 
Full Update, Setup updates the Stacker drives and recompresses the data immediately. If you choose 
Quick, you can recompress the drives later to get the full advantage of Stacker.

On each drive to be compressed, Setup reserves some free working space (about 1 MB on a boot drive 
or 100 KB on others) for files that must remain uncompressed. If the disk contains a Windows permanent 
swap file, Setup reserves space for it on the uncompressed drive as well. This reserved space is 
sometimes called Stacker's working drive.

Then Setup creates a special file called STACVOL.DSK in the root directory. Every STACVOL file has two 
major components. The header area contains control information that Stacker uses to store and retrieve 
your data. The data area contains all the compressed data and unused space. The STACVOL file is 
actually your Stacker drive.

Stacker Setup compresses all files one by one and stores them in STACVOL.DSK. As it transfers files, 
Setup continually enlarges the STACVOL.DSK file.

When all the files are compressed, Setup enlarges the STACVOL to fill the space. It optimizes the 
uncompressed disk to make sure the STACVOL file itself isn't fragmented. And, it adjusts the 
compression ratios as needed so it can project free space.

Setup also has to arrange for access to the compressed data. It adds driver information to define the 
STACVOL file as a Stacker drive. Exactly how it does this depends on whether or not the computer can 
preload compression information. In either case, however, Setup creates a STACKER.INI file that 
contains configuration information for the Stacker driver. The result is the correct drive letter assignment 
for your configuration.

Setup also arranges that as much of Stacker as possible be stored in areas other than your basic 640 KB 
of conventional memory.



After Setup
Once a disk is compressed by Stacker, the Stacker driver resides in memory and works with your 
operating system (DOS) to handle each read or write request. When an application reads data from a 
Stacker drive, the Stacker driver decompresses the needed data as it is read from the disk. The data 
remains in compressed form on the disk. In memory, data is always uncompressed, so the applications 
use it just as they did before. 

When an application writes data to a Stacker drive, the Stacker driver compresses the data as it is written 
to the disk. The moment the data hits the disk it is compressed, so it doesn't take up any extra space.



Data Compression
Basically, data compression is a method of making data use less space on your disk. The result is that 
you can store more data in the same space. 

Stacker uses a patented data compression technique based on Stacker LZS technology. The form of LZS 
used in Stacker 4.0 for Windows & DOS is significantly more effective than earlier versions. LZS and its 
derivatives make the data use less space without losing any information. It uses several techniques to 
accomplish this, including:
· Replacing repeated strings with a single byte token or repeated bytes with a single byte and a repeat 

number. If the word Stacker appears 50 times in a document, using a single byte instead saves 350 
characters.

· Using smaller clusters for storing files and Stacker SmartPack to reduce wasted space to almost 
nothing.

Files such as word processing files, spreadsheet, database, and many graphic formats compress very 
well. Programs (EXE, COM, etc.) don't compress as well. Precompressed formats, such as ARC, ZIP, and 
many animated games, don't compress at all.



Stacker in Memory
If your computer is at least a '386 with more than 1 MB of RAM, and Stacker uses preloaded compression 
(DOS 6 or later), Setup defines a DPMS space (DOS Protected Mode Services) in your extended memory 
and stores most of the Stacker driver high, leaving about 17 KB. If you have upper memory blocks 
available, Stacker automatically uses it.

The Stacker driver takes up some space in memory. Stacker uses as little conventional memory as 
possible. If you have an older operating system, you may be able to store the Stacker cache in EMS or 
upper memory blocks. See the STACKER.INI commands for the switch to use.

For more information, check:
Without DPMS Memory
DPMS Memory



DPMS Memory
DPMS (DOS Protected Mode Services) is a new memory-management standard. It takes a part of 
extended memory, not available to many programs, and lets the system use it safely. If Stacker uses 
DPMS, it won't need much conventional memory at all -- just enough for the DPMS driver.

Stacker Setup will give you DPMS is your system can use it. Your computer must:
· Be a '386 or better
· Have more than 1 MB of RAM
· Use preloaded compression (MS-DOS 6 and above)

Does your computer use DPMS?
If your computer seems to qualify for DPMS, you might want to check to see if it really uses DPMS.

· First examine your CONFIG.SYS file (use ED or any text viewer or editor). If you see lines like these, 
you are set up for DPMS:

DEVICEHIGH=C:\STACKER\STACHIGH.SYS
DEVICE=C:\STACKER\DPMS.EXE

The STACHIGH line causes DOS to store the Stacker cache in extended memory. The DPMS line 
defines the DPMS space in extended memory; the rest of the Stacker driver will be stored here. 
These two lines must be in this sequence, and your system must be able to use extended and upper 
memory.
Notice that DPMS is not loaded high. If you use a memory manager such as MEMMAKER, that uses 
DEVICEHIGH for this line, just edit the CONFIG.SYS file (use ED) and change "DEVICEHIGH" to 
"DEVICE" on this line.

· Next, watch the messages when you start up your computer. Just after the Stacker message, you 
should see a message beginning with "DPMS" and followed by Novell copyright information. 

· Finally, you can see how much space Stacker uses in memory. Here's how:
1. Get to a DOS prompt.
2. Type MEM /C /P and press ENTER.
3. Examine the result. You'll see that DPMS is in conventional memory and takes less than 2 

KB. STACHIGH is in upper memory and takes about 16 KB. No other Stacker components 
occupy conventional or upper memory.

Controlling DPMS

You can turn DPMS off if necessary. If you do, the Stacker driver will take up more space in lower 
memory.

You can turn DPMS on or off at the DOS prompt. Of course, DPMS won't work unless the DPMS.EXE file 
is stored on your hard disk and referenced by a DEVICE= line in your CONFIG.SYS file.

To control DPMS from the DOS prompt
1. Get to a DOS prompt.
2. Type CONFIG /D- to turn it off or CONFIG /D to turn it on.
3. Restart your computer.

To turn off DPMS through CONFIG.SYS
· Edit the CONFIG.SYS file (use ED) and type REM and a space at the beginning of the DPMS.EXE 

line.

To turn DPMS back on through CONFIG.SYS
· Edit the CONFIG.SYS file (use ED) and delete REM and any spaces at the beginning of the 



DPMS.EXE line.



Stacker Configuration
To handle the compressed data, Stacker must define the Stacker drives at startup so they are accessible.

Many recent operating systems can automatically load compression drivers before they process the 
CONFIG.SYS file. This process is often called preloading compression. As a result, your system works 
more safely and efficiently. Your operating system has this capability if it is one of these versions or later: 

· MS-DOS 6
· MS-DOS 6.2
· PC-DOS 6.1 (with files dated after September, 1993)
· Novell DOS 7

With the recent operating systems, the Stacker driver uses a hidden file called DBLSPACE.BIN and is 
automatically loaded when you start your computer. With earlier operating systems, the Stacker driver is 
loaded from a command in CONFIG.SYS. Both methods use configuration information from the 
STACKER.INI file. 

Stacker in Memory
Preloaded Stacker Configuration
NonPreloaded Stacker Configuration (before DOS 6)
The STACKER.INI File



Stacker Configuration - Preloaded
Since MS-DOS 6, the operating system automatically detects and loads data compression drivers without 
the need for extra commands in your CONFIG.SYS file. With recent operating systems (since DOS 6), 
Stacker uses a hidden file named DBLSPACE.BIN.

This preloading integrates data compression tightly with the operating system. It lets any new drive letters 
be assigned and active before CONFIG.SYS and other programs see them. Stacker Setup creates a new 
DBLSPACE.BIN. Setup also creates a file called STACKER.INI that provides information to the driver. At 
startup, DBLSPACE.BIN uses the information in STACKER.INI to configure Stacker and load the Stacker 
driver into memory.

The STACKER.INI File
Editing the STACKER.INI File 



Stacker Configuration-Not Preloaded

On systems running versions of DOS prior to MS-DOS 6, the Stacker device driver is defined in the 
CONFIG.SYS file. You'll see this line in your CONFIG.SYS file:

DEVICEHIGH=C:\STACKER\STACKER.COM

If your Stacker files are stored in a directory other than C:\STACKER, that path appears instead. The 
DEVICEHIGH command lets DOS load the driver in upper memory blocks if there is any space available. 
You'll have to make sure your system is capable of loading programs "high." Just check your operating 
system's or memory manager's documentation. If you requested that Stacker use expanded memory 
(EMS), Setup adds the appropriate switch to your STACKER.INI file.

Any Stacker drives that are created from existing data are mounted swapped; that is, the drive letter 
assigned to the new Stacker drive is exchanged with the original drive letter. The result is that your data 
uses the same drive letter as before. If any of your Stacker drives are swapped, you'll see this line in your 
CONFIG.SYS file as well:

DEVICE=C:\STACKER\SSWAP.COM

Information needed by either of these device drivers is stored in a special file named STACKER.INI. You 
can examine or edit STACKER.INI if necessary.

NOTE:    Earlier Stacker versions included various switches on device driver lines to control how the 
drivers worked. All such information is now supplied through the STACKER.INI file.

The STACKER.INI File
Editing the STACKER.INI File 



The STACKER.INI File
The STACKER.INI file contains configuration information for the Stacker device drivers, whether or not 
compression is preloaded. Stacker Setup creates STACKER.INI as a hidden file in the root directory of 
your boot drive if it doesn't already exist. Other Stacker commands modify it as needed. The same 
information is used whether or not compression is preloaded.

Normally, you won't have to worry about STACKER.INI. Just in case, however, Stacker provides a special 
editor (ED) you can use to edit STACKER.INI or most other text files.

Suppose your computer has a single hard drive. The STACKER.INI file created by Express Setup might 
contain these lines:

/DIR=C:\STACKER\
/P=10
C:\STACVOL.DSK,SW 

STACKER.INI contains two types of lines: commands and drive specifications. Every command occupies 
a separate line in the file; most commands (all except * and @) start with /. Each drive specification 
occupies a separate line in the last part of the file. 
· The first line in the example gives the path where the Stacker files are located. 
· The second line sets the compression tuning level.
· The last line in the example specifies the full name of the STACVOL file; the SW indicates that its 

drive letter is swapped with the original drive.

After this file is processed, drive C holds the compressed data and drive D holds uncompressed data and 
the STACVOL file.

Commands for the STACKER.INI File
Drive Specifications for the STACKER.INI File
Editing the STACKER.INI File
Multidrive STACKER.INI File - Example



Commands for the STACKER.INI File
STACKER.INI normally contains only the commands needed to configure your system. Default settings 
don't appear. You can use the following commands if necessary.

        Command               Effect
* Reserves a drive letter for future use.
@ Reserves a location for a replaceable drive. The drive letter is always the same as 

the original drive. To reserve two locations, use @ twice on separate lines.
/AUTO Lets Stacker mount removable drives. If STACKER.INI includes at least one @, also 

turns on automounting, which adds to the driver size.
/BD=x Specifies the base drive letter (x) from which to start Stacker drives. This may appear 

if Stacker converted from DoubleSpace drives to maintain the DoubleSpace drive 
letter assignments. For example, if the first DoubleSpace drive was assigned to drive 
letter F, /BD=F appears in STACKER.INI and F is assigned to the first Stacker drive. 
Valid only in DOS 6 and later systems that use preloaded compression.

/DIR=<path> Specifies the path where the Stacker software is located; it is used by the Stacker 
Interceptor. This command generally occurs at the top of the STACKER.INI file. Valid 
only in DOS 6 and later systems that use preloaded compression.

/P=n Sets the compression tuning. Use any value between 0 and 10. The value 0 turns 
compression tuning off, decreasing memory requirements by 4.4 KB. A setting of 10 
produces the very best compression. Stacker always uses the best possible 
compression while creating or recompressing a Stacker drive.

/RP=n Sets the number of replaceable drives to reserve, in addition to any specific drive 
specifications.

For more information:
Advanced STACKER.INI Commands 



Advanced STACKER.INI Commands
In special cases, you might want to add additional commands to your STACKER.INI file. These 
commands are available:

        Command               Effect
/C or /C=n Specifies the cluster size as the default (/C) or 4, 8, 16, or 32 KB. It must be at least 

as large as the smallest cluster size in use. Don't change this value; it is established 
when the Stacker drive is created.

/EMS Indicates that Stacker's disk cache (up to 64 KB) should be stored in expanded 
memory, if any is available. If you use /EMS, you won't be able to use /UMB. If you 
use DPMS, /EMS has no effect.

/I- Turns off Stacker's DOS command interceptor, saving 2 KB in memory. Normally 
used with Novell networks.

/LHF- Turns off Stacker's normal clearing of the cache used by SmartDrive under MS-DOS 
6 when any application ends.

/-LZS Turns off Stacker's search for an external compression server like those used by 
Stacker hardware. Needed only with some older configurations when the system 
refuses to boot.

/M=n Sets the cache memory size to n KB. Use any value between 1 and 64. The amount 
of driver memory required increases by whatever you specify up to a maximum of 64 
KB for the cache (The /M switch has no effect if you use it with /EMS.) If you use 
DPMS, /M=n has no effect.

/Q- Turns off normal quiet startup. This switch causes your Stacker drives and their 
uncompressed drives to be listed at Startup, along with other program and copyright 
information.

/SW=swap-pairs Sets up multiple swapping that takes place after individual drives are mounted and 
swapped. If necessary, use /SW to specify swapping to occur after all Stacker drives 
are mounted. See Drive Specifications for more details.

/UMB Indicates that Stacker's disk cache should be stored in upper memory blocks, if 
space is available. If you use /UMB, you won't be able to use /EMS. If you use 
DPMS, /UMB has no effect.

/W- Disables Windows permanent swap file pointer updating. By default, if Stacker 
detects a Windows permanent swap file on a disk that was swapped, Stacker 
searches through its preset pattern for the Windows directory and places the full path 
of the Windows permanent swap file in SPART.PAR in the Windows directory. Once 
this is done (the first time you restart your system after compressing the disks that 
contain the permanent swap file), it really doesn't have to be done again unless you 
make drastic changes to your system. If you add /W- to the STACKER.INI file, the 
search won't take place, and you'll save a bit of time at startup.
NOTE: Stacker checks for a Windows permanent swap file every time you restart 
your system. Adding /W- shortens startup time, especially if you don't have Windows.

/W=<directory> Names the directory that contains your permanent swap file pointer (SPART.PAR). 
Use this switch if your directory has an unusual name or isn't on the default path that 
Stacker searches. If Windows can't find its permanent swap file after you compress a 
disk, add this switch and restart your system. This switch tells Stacker exactly where 
to find the SPART.PAR file, saving a bit of time at startup. Replace it with /W- after 
Windows finds its swap file.

/W+<directory> Names the directory that contains your permanent swap file. Use it if your directory 
has an unusual name or isn't on the default path that Stacker searches. It causes 
Stacker to search its regular default path and find this one, too, just in case you have 
multiple swap files. This command actually lengthens the search but ensures that it 
finds all the files.



Drive Specifications for the STACKER.INI File

Each Stacker drive on the system is represented by a drive specification line in the STACKER.INI file. 
Each drive specification gives the full name and path to the STACVOL file (such as C:
\STACVOL.DSK,SW) and includes a mounting parameter that specifies how the Stacker drive is 
mounted. If you remove a drive specification, that drive will not be mounted automatically.

These parameters specify the mounting method for the Stacker drive. A comma precedes each one.
NS Mount without swapping, using the next available drive letter. Used for Stacker drives created from 

free space or additional Stacker drives on the same original uncompressed drive. You can access 
data on the original uncompressed drive by using its original drive letter.

RP Mount replaced. Usually applies to removable and RAM disks. You won't be able to access data on 
the original uncompressed drive while the Stacker drive is mounted.

SW Mount swapped, using the next available drive letter. Used for Stacker drives created from existing 
data. You can access data on the original uncompressed drive by using the new drive letter.

When you create a Stacker drive using the Stacker Toolbox or Setup, Stacker inserts the appropriate 
mounting parameter in the drive specification. 

If the drive specification includes SW, mounting the Stacker drive causes the drive letter swapping to 
takes place. To delay swapping until all Stacker drives are mounted, use the separate /SW command. To 
set up multiple swapping, use a line like this:

                      /SW = jk mn xy

After it mounts all drives, Stacker will swap drives in pairs: J with K, M with N, X with Y, and so on, up to 
26 swaps. Most users don't need multiple swapping because the mounting parameter "SW" on the 
STACVOL line handles swapping on an individual drive basis. If you use the /SW= command, put it at the 
TOP of STACKER.INI along with the other commands. Even so, it will be processed after all the drives 
have been mounted.



Multidrive STACKER.INI File - Example

Suppose a computer has two fixed disks. You create these Stacker drives:
· One Stacker drive compresses all the data on drive C (converted from DoubleSpace)
· One Stacker drive compresses data on drive D, leaving about 40 MB free space
· One Stacker drive uses the free space left on D
· One Stacker drive in floppy drive B
· A Stacker RAM drive

The STACKER.INI file might contain these lines:

              Line             What it means
/DIR=C:\STACKER\ Where Stacker files are stored
/P=10 Optimal compression
/RP=1 To let you use compressed floppies in drive A
/BD=H Starts assigning new letters at H (inserted by DoubleSpace conversion)
B: Specifies automount for drive B (mounted replaced)
C:\STACVOL.DSK,SW Stacker drive on C (swapped with H)
D:\STACVOL.DSK,SW Stacker drive on D (swapped with I)
D:\STACVOL.000,NS Second Stacker drive on D (not swapped; Drive D becomes J) 
E:\STACVOL.DSK,RP Stacker RAM drive, replaced

After STACKER.INI is processed, these are the drive letters:

B Automounting removable drive
C Stacker drive
D Stacker drive created first on E (from existing data)
E Stacker RAM drive
F DOES NOT EXIST
G DOES NOT EXIST
H Uncompressed drive containing the STACVOL file for Stacker drive C
I Uncompressed drive containing STACVOL files for Stacker drives D and E
J Stacker drive created second on E (from free space)

Typing STACKER at the DOS prompt gets this result:

 Drive A: was Drive A: at boot time
 Drive B: was Drive B: at boot time [Auto-mounting Stacker drive]
 Drive C: was Drive C: at boot time [H:\STACVOL.DSK = size]
 Drive D: was Drive D: at boot time [I:\STACVOL.DSK = size]
 Drive E: was Drive E: at boot time [E:\STACVOL.DSK = size]
 Drive F: was Drive F: at boot time
 Drive G: was Drive G: at boot time
 Drive H: was Drive H: at boot time
 Drive I: was Drive I: at boot time
 Drive J: was Drive J: at boot time [I:\STACVOL.000 = size]

Editing the STACKER.INI File
Stacker provides the ED editor that you can use to edit STACKER.INI or any other ASCII file. 
STACKER.INI is a hidden file located in the root directory of your uncompressed boot drive, so it's more 
difficult to edit with standard editors.

Start up ED by typing ED at the DOS prompt. You'll be able to choose STACKER.INI (as well as 
CONFIG.SYS or AUTOEXEC.BAT) directly from the File menu. All the lines appear in the editor window.

ED works much like other standard text editors. While it provides a full range of features via its menu bar 



and help system, you can examine or modify STACKER.INI using:
· Arrow keys to position the cursor
· Delete key to remove characters
· Insert key if you have to insert or overtype characters
· Enter to add a new line

When you are finished, use ALT-F followed by X to exit ED. When prompted, press Y if you want to save 
the changes.



Procedures
For more information on performing any of the following, just click the procedure.

Automounting Removable Drives
Adding a Windows Permanent Swap File 

Changing AutoSave Settings
Changing File Attributes 
Changing Passwords
Changing the Expected Compression Ratio
Changing the Stacker Drive Size 
Changing Warning Level for Toolbox Gauges
Checking the Integrity of a Stacker Drive
Compressing a Floppy Disk
Compressing a RAM Disk 
Compressing the Data on Another Disk 
Converting an Unmounted DoubleSpace or SuperStor/DS Drive
Creating an Empty Stacker drive

Defining a Password 
Defragmenting a Disk 
Deleting a Password
Displaying File Attributes

Editing any text file

Identifying Drive Letters 
Installing the Stacker Program Group
Installing the Stacker Screen Saver

Locating a Windows Permanent Swap File

Making More Uncompressed Space 
Monitoring File Compression
Mounting Removable Stacker Drives

Optimizing a Disk 

Rebuilding the Stacker Configuration Files
Recompressing a Disk
Removing a Stacker Drive
Repairing a Stacker Drive
Replacing a Copy of a Damaged STACVOL Header

Tuning Stacker 

Uncompressing a Disk
Using Stacker Anywhere from DOS 
Using Stacker Anywhere from Windows



Updating Stacker Drives Outside Setup
Stacker Setup automatically updates any mounted Stacker drives from earlier versions to the new, 
superior Stacker storage formats. It does not update any removable disks or any Stacker drives on a fixed 
disk that are not mounted.

You can use the HCONVERT command outside of Setup to update removable or unmounted Stacker 
drives to the new format. The process is the same for both. You must run HCONVERT under DOS, rather 
than under Windows.

IMPORTANT: If you use HCONVERT, let it run to completion. Do not interrupt the process.

HCONVERT Syntax 
Updating an Unmounted Stacker Drive
Updating a Removable Stacker Drive



HCONVERT Syntax
The HCONVERT program updates Stacker drives to use Stacker's newest technology and superior data 
compression. If your computer has earlier Stacker drives that weren't mounted when you ran Setup or if 
you have removable Stacker drives to update, you can run HCONVERT at the DOS prompt outside of 
Windows.

                                HCONVERT /C stacvol-filename [/M]
                        or
                                HCONVERT /G old-stacvol-filename new-stacvol-filename [/M]

              Option                 Effect

/C stacvol-filename Updates the named STACVOL file to the new Stacker format. If you don't 
include a drive letter in the path, a file of that name on the current drive is 
updated.

/G old-stacvol-filename new-stacvol-filename
Generates a STACVOL file in the new storage format by copying the 
named old STACVOL file as a new Stacker volume. It doesn't change the 
existing STACVOL file. If you omit the drive letter in either volume-name, 
the current disk is used.

/M Use with either /C or /G on a monochrome monitor.



Updating an Unmounted Stacker Drive
Suppose Stacker drive D was unmounted when you ran Stacker Setup. Setup won't update it 
automatically. Drive D contains the hidden file STACVOL.000. To update the drive, type:

                                HCONVERT /C D:\STACVOL.000

HCONVERT updates the file. It does not mount the drive, however.

To Mount a Stacker Drive Temporarily

To mount a Stacker drive, type STACKER drive:, where drive is the disk that contains the STACVOL file. 
The drive won't be mounted when you restart your computer.

To Mount a Stacker Drive Permanently

HCONVERT does not modify the STACKER.INI file. To make Stacker mount drives you updated outside 
of Setup, use ED to edit the STACKER.INI file and add a drive specification line. For the example above, 
you would type on a new line:

                               D:\STACVOL.000,SW

When you restart your computer, the drive is mounted along with any other drives specified in 
STACKER.INI.



Updating a Removable Stacker Drive
Insert the removable disk into a drive. The STACVOL file is named STACVOL.DSK. Then type:

                                HCONVERT /C drive:\STACVOL.DSK

The Stacker drive is updated.

To have Stacker mount Stacker drives in a removable drive automatically, use ED to edit the 
STACKER.INI file and add a line containing the drive letter and colon, as in B: Then Stacker can 
automatically mount Stacker drives in that drive.



Converting Compressed Disks Outside Setup
Stacker Setup automatically converts any mounted disks previously compressed by programs compatible 
with DoubleSpace and SuperStor/DS to Stacker drives. It does not convert any removable disks or any 
compressed drives on the fixed disk that are not mounted.

You can use the DCONVERT command outside of Setup to convert compressed removable disks or 
unmounted disks compressed by these programs to Stacker drives. The process is the same for both. 
You must run DCONVERT at the DOS prompt, outside of Windows.

IMPORTANT: If you use DCONVERT, let it run to completion. Do not interrupt the process.

DCONVERT Syntax
Converting an Unmounted Compressed Drive
Converting a Compressed Removable Disk 



DCONVERT Syntax
The DCONVERT program converts disks compressed by a program such as DoubleSpace or 
SuperStor/DS to Stacker drives that use Stacker's newest technology and superior data compression. If 
your computer has compressed removable disks or compressed drives that weren't mounted when you 
ran Setup, you can run DCONVERT at the DOS prompt outside of Windows.

                                DCONVERT /C compressed-volume-name [/M]
                        or
                                DCONVERT /G compressed-volume-name stacvol-filename [/M]

                  Option                     Effect

/C compressed-volume-name Converts the named compressed volume to the new Stacker format. If 
you don't include a drive letter in the path, a file of that name on the 
current drive is updated.

/G compressed-volume-name stacvol-filename
Generates a STACVOL file in the new format by copying the named 
compressed volume as a new Stacker volume. If you omit the drive letter 
in either volume-name, the current disk is used.

/M Use with either /C or /G on a monochrome monitor.

DCONVERT needs some working space on a disk to convert it, as much as 1 MB depending on the 
situation. If it runs out of space, you'll see a WRITE ERROR. There is no problem. Just use /G instead to 
make a converted copy of the compressed volume file on a different disk. Then use COPY to transfer the 
resulting STACVOL file to the disk you want it on.

You will have to change the attributes of the original file in order to delete it.



Converting an Unmounted Compressed Drive
Suppose DoubleSpace drive D was unmounted when you ran Stacker Setup. Setup doesn't convert 
unmounted disks. Drive D contains the hidden file DBLSPACE.000. To convert the drive, type:

                             DCONVERT /C D:\DBLSPACE.000

The file is converted and renamed to STACVOL.DSK. DCONVERT does not mount the drive, however.

To Mount a Stacker Drive Temporarily

To mount a Stacker drive, type STACKER drive:, where drive is the disk that contains the STACVOL file. 
When you restart your computer, this drive will be unmounted again.

NOTE: If you see a message that there is no available replaceable drive, edit the STACKER.INI file to add 
/RP=2. If you already have a /RP command, increase its value by at least one.

To Mount a Stacker Drive Permanently

DCONVERT does not modify the STACKER.INI file. To cause a converted drive to be mounted when you 
restart your system, use ED to edit the STACKER.INI file and add a drive specification line. For the 
example above, you would type on a new line:

                               D:\STACVOL.DSK,SW

When you restart your computer, the drive is mounted along with any other drives specified in 
STACKER.INI.



Converting a Compressed Removable Disk
Insert the disk into a drive and type DIR drive: /AH to identify the name of the hidden DoubleSpace 
volume. Then type:

                                DCONVERT /C drive:\dblspace-volume-name

The volume is converted and named STACVOL.DSK.



Compressing Data on Another Disk
Once you have installed Stacker 4.0 on your computer, you can compress any disk that is not yet 
compressed. 

To compress data on a disk
1. In the Stacker Toolbox, choose any uncompressed drive.
2. Choose the Compress tool.
3. If you chose an empty removable drive, Stacker creates an empty Stacker drive using all the available 

space.
4. If you chose any other drive, Stacker starts the Setup program.
5. When Setup starts, choose the disk to be compressed and proceed as in Custom setup.



Creating an Empty Stacker Drive
If you do not wish to compress any data already on the disk and there is enough uncompressed space on 
it, you can ask Stacker to create a new empty Stacker drive for you. Stacker can create an empty Stacker 
drive on a removable or fixed disk.

To compress an empty floppy or other removable disk
1. Insert the empty disk into the disk drive.
2. From the Stacker Toolbox, select that removable drive.
3. Choose the Compress tool.

Stacker creates and verifies the drive.
5. Choose OK after the disk is created.

To create an empty Stacker drive on a disk that contains data
1. From the Stacker Toolbox, choose any uncompressed drive.
2. Choose the Compress tool.
3. When Stacker Setup begins, choose OK to exit Windows and continue under DOS.
4. When prompted, choose the drive on which you want to create an empty Stacker drive.
5. To create an empty Stacker drive, choose Free Space.
6. Type the amount of space to use for the disk. The resulting Stacker drive will be more than twice this 

size.
7. Follow the instructions to let Setup finish creating the drive and return to Windows.

If you want a drive to mount Stacker disks automatically, all you have to do is make a minor edit to your 
STACKER.INI file -- simply add the drive letter (and a colon) on a line by itself. For example, if you want 
drive B to mount Stacker disks automatically, do the following. 

To make a drive, such as drive B, automatically mount Stacker disks
1. Exit Windows so you are working in DOS.
2. Go to your Stacker directory, usually C:\STACKER.
3. At the prompt (for example, C:\STACKER>), type ED and press ENTER to open the text editor supplied 

with Stacker. 
4. From ED's File menu, choose STACKER.INI.
5. Add a new line and type:

B:
6. Save the change and exit.
7. Restart your computer.

Note: If you want more than one drive to mount Stacker disks automatically, you must add a separate line 
for each drive in STACKER.INI. 

For more information, see Editing the STACKER.INI File.



Compressing a RAM Disk
RAM drives can be created in the CONFIG.SYS or AUTOEXEC.BAT file. To automatically double the 
capacity of a RAM drive created in CONFIG.SYS, you can include an SCREATE.SYS device statement 
following the line that creates the RAM drive. This example creates a 4 MB RAM drive and then creates a 
10 MB Stacker drive from it:

DEVICE=C:\DOS\RAMDRIVE.SYS 4096 /A
DEVICE=C:\STACKER\SCREATE.SYS E:

The SCREATE.SYS driver command must include the drive letter of the RAM drive. SCREATE doesn't 
remain in memory.

If the RAM drive is created in the AUTOEXEC.BAT file, use a line like this one following the one that 
creates the RAM drive:

CREATE E:

To let Stacker mount the compressed RAM drive automatically under MS-DOS 6 if both the RAMDRIVE 
and SCREATE lines appear before STACHIGH.SYS. Just use ED to edit STACKER.INI and add E:
\STACVOL.DSK,RP (in this example) to a new line at the end.

If the RAM drive isn't automounted, use STACKER drive: at the DOS prompt to mount it.



Locating Windows Permanent Swap File

If Stacker finds a Windows permanent swap file, but doesn't find the SPART.PAR file that points to it, you'll 
see the following message:

"SSWAP Warning: Located a Windows permanent swap file on a disk to be swapped, but could 
not find the Windows file, SPART.PAR, pointing to it. Press any key to continue..."

The easiest way to correct the problem is to tell Stacker exactly where the Windows file is currently 
located.

You'll have to edit the STACKER.INI file and add a command.

To tell Stacker where Windows is located
1. Get to a DOS prompt.
2. Type ED and choose STACKER.INI from the File menu.
3. Move the cursor to the beginning of one of the command lines and press ENTER to insert a new line.
4. Type /W=drive:\path where drive:\path is the drive and path where your Windows files are stored.
5. Exit ED and save the file (press ALT-X, then press ENTER).
6. Restart your computer.



Automounting Removable Stacker Drives
If you wish to bypass Stacker Anywhere and have Stacker automatically mount Stacker drives in any of 
your removable drives, all you have to do is make a minor change to your Stacker configuration. You 
simply add the drive letter (and a colon) to your STACKER.INI file. For example, if you want drive B to 
mount Stacker disks automatically, do the following. 

To make a drive, such as drive B, automatically mount Stacker disks
1. Exit Windows so you are working in DOS.
2. Go to your Stacker directory, usually C:\STACKER.
3. At the prompt (for example, C:\STACKER>), type ED and press ENTER to open the text editor supplied 

with Stacker. 
4. From ED's File menu, choose STACKER.INI.
5. Add a new line and type:

B:
6. Save the change and exit.
7. Restart your computer.

Note: If you want more than one drive to mount Stacker disks automatically, you must add a separate line 
for each drive in STACKER.INI. 

For more information, see Editing the STACKER.INI File.



Using Stacker Anywhere from Windows
Stacker Anywhere is stored on the removable disk, so you can give a Stacker-compressed floppy to a 
colleague who doesn't yet have Stacker, and he can access all the data and free space on the disk. 

Stacker Anywhere lets you mount a Stacker-compressed removable disk. Your Windows applications can 
then read and write data on the disk. Once you start Stacker Anywhere, it remains in memory until you 
exit Windows so you can mount and unmount disks at any time. Stacker Anywhere for Windows handles 
one removable disk at a time. If you mount a second, Stacker Anywhere unmounts the first.

To mount a removable Stacker drive under Windows
1. Start Windows File Manager.
2. Insert the removable disk into the disk drive.
3. Click the drive icon for that drive.
4. Double-click STACKER.EXE (a file listed on the drive)
5. Click OK when prompted to mount the disk.
6. Click OK again when prompted.
7. Click the drive icon again to refresh File Manager and display any files on the Stacker drive.

If you want to access your Stacker drive under both Windows and DOS, use Stacker Anywhere from DOS 
instead.

To unmount a removable Stacker drive under Windows
1. Start Windows File Manager.
2. Insert the removable disk into the disk drive, if necessary.
3. Click the drive icon to choose that drive.
4. Press ALT-TAB until you see the Stacker Anywhere icon.
5. Choose Unmount from the Stacker Anywhere menu.
6. Click OK



Using Stacker Anywhere from DOS
If your computer doesn't automatically mount removable Stacker drives, you can mount them from your 
Stacker directory (if you have Stacker installed) or use Stacker Anywhere from the removable itself. Once 
the disk is mounted under DOS, you can access it fully under both DOS and Windows.

To mount a removable Stacker drive under DOS
1. Exit Windows to get to the DOS prompt.
2. Insert the removable disk into the disk drive.
3. Type drive: to change to that drive.
4. Type DIR and press enter to see what files are listed. STACKER.EXE indicates that Stacker 

Anywhere is present on the disk.
5. Type STACKER at the DOS prompt and press ENTER.

You'll see a message telling you the disk is mounted. When you remove it or restart your computer, 
Stacker unmounts the drive. 

To unmount a Stacker drive under DOS
1. Exit Windows if necessary and get to the DOS prompt.
2. Change to the removable drive.
3. Type EXIT.

To unmount other Stacker drives mounted under DOS
1. Exit Windows if necessary and get to the DOS prompt.
2. Type STACKER drive:



Mounting Removable Stacker Drives
If you'll be using compressed floppies or other removables regularly, you might want to have Stacker 
automatically mount them for you. Stacker can automatically give you access to data on the disk without 
your having to mount it. See Automounting Removable Stacker Drives for full details. 

If you want to use the STACKER drive: command at the DOS prompt to mount removable Stacker drives, 
you'll have to modify your STACKER.INI file.

To change STACKER.INI so Stacker can mount removable drives
1. At a DOS prompt, type ED.
2. From the File menu, choose STACKER.INI.
3. Press ENTER to start a new line.
4. Type /RP=1 or /RP=2 on the line, depending on whether you want to use one or two removable 

Stacker drives at a time.
5. From the File menu, choose Exit, then press ENTER to save the changes.
6. Restart your computer.



Identifying Drive Letters
You may occasionally want to know the full name of the STACVOL file that is a Stacker drive or the drive 
letter assigned to the Stacker drive or the uncompressed drive on which it resides. 

To identify Stacker drive and uncompressed drive letters
· At a DOS prompt, type STACKER and press ENTER.

The listing includes lines like these:

Drive C: was drive C: at boot time.  [D:\STACVOL.DSK=42MB]
Drive D: was drive D: at boot time.

Stacker drive C is contained in the file STACVOL.DSK on the uncompressed D drive.

If Stacker isn't preloaded on your system, the lines look like these:

Drive C: was drive D: at boot time.  [D:\STACVOL.DSK=42MB]
Drive D: was drive C: at boot time.



Adding a Windows Permanent Swap File
If a Windows permanent swap file is present when you set up Stacker, Stacker Setup reserves space for 
it on the uncompressed drive, since swap files must remain uncompressed. If you add Windows to your 
system after setting up Stacker, your uncompressed drive won't have room for the permanent swap file. 
Stacker lets you store it on the Stacker drive and keeps the file uncompressed to ensure full-speed 
access.

To build a permanent swap file on a Stacker drive
1. Select any Stacker drive in the Stacker Toolbox.
2. Choose the Configure tool.
3. Click Change swap file settings.
4. Click Change>>.
5. Choose the Stacker drive to hold the swap file.
6. Choose Permanent as the Type.
7. Accept the recommended New Size or type the size you want.
8. Choose OK.

For more information, see Using Virtual Memory



Changing the Expected Compression Ratio
When Stacker compresses data to create a Stacker drive or recompresses data on an existing Stacker 
drive, it automatically adjusts your expected compression ratio to be approximately equal to the actual 
compression ratio for the data on that disk. However, if you have added much data to your disk and your 
ratios do not match, you can change the expected compression ratio. No matter how you do it, the 
process takes some time, depending on the size of your Stacker drive.

To let Stacker adjust your expected compression ratio
1. Select the Stacker drive in the Stacker Toolbox.
2. Choose the Optimize tool.
3. Choose Full-MaxSpace to let Stacker fully optimize and recompress the drive.
4. Choose OK to let the Optimizer exit Windows.
5. Follow the instructions on the screen.

If you prefer to specify the expected compression ratio yourself, use the next procedure. You must exit to 
DOS to perform this operation. 

To change your expected compression ratio using the Stacker DOS Toolbox
1. At the DOS prompt, type STAC and press ENTER.
2. Use    to highlight Expected Compression on the left side of the screen, then press ENTER.
3. If you have more than one Stacker drive, choose the one to be changed.
4. When prompted, press any key so Stacker can optimize the drive, if necessary.
5. Type the desired expected compression ratio. You'll see the acceptable range and a recommended 

setting. Then press ENTER.
6. To make the change, choose Perform changes on Stacker drive.
7. When prompted, press any key to restart your computer and put the changes into effect.



Changing the Stacker Drive Size
The Stacker drive occupies space on an uncompressed drive. In rare situations, you may need more 
space on your Stacker drive or more uncompressed space. If Stacker has to optimize your drive, the 
process will take a while.

To change the Stacker drive size
1. From the Stacker Toolbox, select the Stacker drive.
2. Choose the Configure tool.
3. Choose Change Stacker drive size and click OK.
4. Click OK to leave Windows and complete the operation.
5. To make the Stacker drive larger, choose Increase Stacker drive size. To make the Stacker drive 

smaller, choose More uncompressed space available.
6. When Stacker displays the acceptable size range, type the size you want the final Stacker drive to be.
7. To make the change, choose Perform changes on Stacker drive.
8. When prompted, press ENTER to restart your system.



Rebuilding the Stacker Configuration Files
If you can't access your Stacker drives when you restart your computer, you may have to rebuild your 
Stacker configuration files. 

To rebuild the Stacker configuration files
1. At the DOS prompt, change to drive C and type

C:\STACKER\CONFIG
Then press ENTER.

2. Press Y to let CONFIG make its changes.
3. Restart your computer.

If you still can't get at your data and you are using preloaded compression, the DBLSPACE.BIN file may 
be damaged. Stacker provides a special command you can use to restore it.

To restore DBLSPACE.BIN
1. Using the same disks from which you installed Stacker, change to that drive or directory.
2. At the DOS prompt, type \TOOLS\REDBL\drive: where drive is the uncompressed letter of the boot 

drive. If no Stacker drive is mounted, use C.
3. When the DOS prompt returns, remove any floppy disk and restart your computer.



Removing a Stacker Drive
You can remove a Stacker drive in either of two ways. The usual way is to uncompress the data, 
removing the Stacker drive without losing any of your data. The other way is to delete the Stacker drive, 
compressed data and all.

To uncompress the data, use the Uncompress tool (see Uncompressing a Disk.)

To delete the entire Stacker drive and its data
1. Exit Windows completely and get to the DOS prompt.
2. Type REMOVDRV drive: where drive: is the letter of the Stacker drive.
3. Confirm the operation when Stacker asks.

The Stacker drive is gone along with the compressed data.



Repairing a Stacker Drive
If the Check tool reports any problems under Windows, you'll have to make repairs under DOS.

To repair Stacker drives under DOS
1. Exit Windows completely and get to a DOS prompt.
2. Type STAC to open the Stacker DOS Toolbox.
3. Choose Check Drive Integrity and press ENTER.
4. When CHECK asks if it should make repairs, let it.
5. When CHECK asks if it should do a surface test, let it.
6. When you return to the Stacker Toolbox, press F10, then ENTER to exit.

After running CHECK to repair a disk, it's a good idea to run CHKDSK to make sure there are no 
corresponding DOS problems.



Replacing a Copy of a Damaged STACVOL Header
Stacker automatically saves all your STACVOL headers whenever you start your computer. Each header 
is stored in a hidden file named STACSAVx.yyy in the root directory of the uncompressed drive that holds 
the STACVOL file. The yyy is the same as the extension of the STACVOL file (usually DSK). The x is 
either Q or E. STACSAVQ is usually a header saved at boot time. 

If a STACVOL header is damaged, you may get a message when starting your system that a Stacker 
drive couldn't be mounted because it is "not a Stacker STACVOL" or it has an "invalid number of reserved 
sectors." In either case, you can use the REPAIR utility to replace the latest version of the header.

To replace a damaged STACVOL header on drive C
1. Start up your computer (use a startup floppy disk if necessary).
2. Type STACKER if necessary to identify the drive that contains C:\STACVOL.DSK.
3. Change to that drive.
4. Type DIR STACSAV*.* /AH to list all the saved header files. (/AH lists hidden files)
5. Identify the one with the latest date and/or time. Notice if the filename is STACSAVE or STACSAVQ.
6. If the latest saved header file is STACSAVE (ending with E) type:

      REPAIR /F drive:/STACVOL.xxx and press ENTER.
7. If the latest saved header file is STACSAVQ (ending with Q) type: 

      REPAIR /F drive:/STACVOL.xxx /Q and press ENTER.

When you restart your computer, Stacker should be able to mount the drive. To repair a damaged header 
on another drive, use the appropriate drive letters in your commands.



Displaying File Attributes

To display hidden and system files in File Manager
1. Open the File Manager.
2. On the View menu, choose By File Type.
3. Check Show Hidden/System Files

To display file attributes in Windows
1. Open the File Manager.
2. Select the file or files.
3. Choose Properties from the File menu.
4. Notice the Read Only, Hidden, System, and Archive check boxes. If the box is grayed, some of the 

selected files are on () and some are off (clear).
5. Choose OK.

To display file attributes at the DOS prompt
1. Get to a DOS prompt.
2. Type ATTRIB full-file-name and press ENTER.



Changing File Attributes
Stacker protects many of its files by applying read-only, system, and hidden attributes to them. You may 
have to remove these attributes to perform some operations. Whenever you restart the system, Stacker 
reapplies these attributes to any STACVOL files.

To display hidden and system files in File Manager
1. Open the File Manager.
2. On the View menu, choose By File Type.
3. Check Show Hidden/System Files

To change file attributes in Windows
1. Open the File Manager.
2. Select the file to be changed.
3. Choose Properties from the File menu.
4. Click the Read Only, Hidden, and System check boxes. When they are clear (empty), the attributes 

are turned off.
5. Choose OK.

To change file attributes at the DOS prompt
1. Identify the full name of the file to be changed. (Type STACKER to see the STACVOL file names.)
2. Type ATTRIB -R -S -H fullfilename and press ENTER.



Using Stacker 4.0 With Other Products
Stac maintains comprehensive product support services (PSS) to help you get the most out of Stacker. 
The brochure included in your Stacker package explains how to use them.

Stacker 4.0 works seamlessly with other software and with your hardware. In a few situations, however, 
you may have to take some extra steps.

Anti-Virus Programs
Lantastic File Servers
Netroom 1.12
Norton Utilities 7.0

You can obtain additional information about how Stacker works in unusual situations or with particular 
hardware or software from our StacFax system. Stac makes information on many topics available. 
Customers in the United States and Canada can call the StacFax number listed in the product support 
brochure provided in your Stacker package. Customers in other countries can obtain this information from 
other sources listed in the same brochure.

You might find these topics particularly interesting or useful:

StacFax #       StacFax Title
      1000 StacFax Index
      4001 Stacker Setup on IBM PS/2 with an External Sysgen Drive
      4002 Compressing a Floppyless Notebook
      4003 Compressing a Palmtop
      4301 DR DOS & Norton Disk Doctor with Multiple Stacker Drives
      4401 PC-KWIK Disk Cache Reports Boot Sector Mismatch
      4402 Using Disk Technician on a Stacker Drive
      4501 Adaptec SCSI Disk Controller with Stacker
      4502 Early ALR VEISA Computers & Stacker
      4503 Mounting Plus Passport Removable Hard Drives
      4504 Loading Stacker high with WD 7000-FASST SCSI Controllers

Many other topics are available as well. They are all listed in the StacFax Index.



Norton Utilities 7.0
In most cases, Stacker drives work well with the Norton Utilities. This section details the exceptions.

Norton Rescue Disk rather than Stacker Startup Disk

To make a Stacker Startup disk to use with Norton Utilities
1. Start with a Norton Rescue disk rather than an MS-DOS 6 startup disk.
2. Set up Stacker 4.0.
3. Insert your Norton Rescue disk into drive A.
4. At the DOS prompt, type SYS A: and press ENTER to make the disk Stacker-aware.
5. Relabel the disk "Stacker Startup Disk - Norton Rescue" and put it away.

Norton Disk Doctor
Norton Disk Doctor is compatible with disks compressed by Stacker. However, if you have converted a 
DoubleSpace drive and not yet used Stacker Optimizer to recompress the data, using Norton Disk Doctor 
may result in data loss. It's a good idea to recompress your converted drives right away for better 
compression and to avoid this problem.

Norton Safe Format
Norton Safe Format, when used from a Stacker boot drive, does not create a correct boot sector on the 
floppy disk being formatted, so the disk can't be used for booting. To create a bootable floppy disk, use 
the DOS FORMAT command instead.

Make Disk Bootable utility
The Make Disk Bootable utility does not copy DBLSPACE.BIN to the floppy disk being formatted. To 
create a bootable floppy disk, use the DOS FORMAT or SYS command.



Netroom 1.12
Netroom 1.12 does not properly retain the device attributes of the drivers it loads into high memory. Do 
not load Stacker into high memory if you use Netroom 1.12.



Lantastic File Servers
You can use Stacker compression on DOS-based networks such as Lantastic. Stacker can compress the 
data on Lantastic file server drivers. The necessary Lantastic files will be placed on the new Stacker drive. 
Network workstations without Stacker loaded can access Stacker drives on a Lantastic network file 
server.

However, you cannot run Stacker utilities on Stacker drives when Lantastic is loaded. The messages 
indicate the drive isn't a Stacker drive. In order to use the Stacker tools, you'll have to restart the 
computer without Lantastic.

NOTE: Reports of available disk space won't accurately reflect the projected amount of space available 
on the server's Stacker drives, but will instead match the amount reported as available by the DOS 
CHKDSK command.



Anti-Virus Programs
At times, Stacker must work at a very low level on your disk. Some anti-virus programs find such activity 
suspicious. You may have to disable your anti-virus program before doing certain Stacker functions.

During Setup
When Stacker Setup restarts your computer before compressing any disks, it disables all TSRs, including 
anti-virus programs. This happens automatically if you choose Express Setup, although you can bypass 
the restart during Custom Setup. When Setup is finished, it restarts your computer in its usual way. If you 
don't let Setup restart before compressing disks, you should disable or unload your anti-virus program 
before running Setup.

During Recompressing or Uncompressing a Stacker Drive
If your anti-virus program interfered with Setup, you'll have to unload or disable the anti-virus program 
when you use the Stacker Optimizer to recompress a disk or when you remove Stacker by 
uncompressing a disk.

Central Point Anti-Virus
If you compressed the data on your boot drive and you use the BOOTSAFE anti-virus program, you must 
tell BOOTSAFE to check your uncompressed drive rather than the Stacker drive. 

1. Type STACKER to find the uncompressed drive letter that contains STACVOL.DSK for the boot drive.
2. Use ED (choose AUTOEXEC.BAT from the File menu) to add a line like this to your AUTOEXEC.BAT 

file:

BOOTSAFE drive:            where drive: is the uncompressed drive letter.

Norton AntiVirus
Norton AntiVirus from Norton Desktop for Windows 2.2 fails to load if all the following conditions occur 
together:
· 386MAX version 6.02 is in use (but not 6.01 or 6.03)
· STACHIGH.SYS is loaded high using the 386MAX 386LOAD.SYS program (not using DOS' 

DEVICEHIGH)
· NAV&.SYS is loaded after STACHIGH.SYS

The easiest way to make NAV&.SYS load is to use DEVICEHIGH instead of 386LOAD.SYS.



Installing the Stacker Screen Saver
Stacker provides a special screen saver that you can use with Windows 3.1. 

To install the screen saver under Windows 3.1
1. In Windows Program Manager, double-click the Control Panel icon.
2. From the Control Panel, double-click the Desktop icon.
3. Under Screen Saver, click the arrow and select the Stacker screen saver.
4. Choose OK.



Installing the Stacker Program Group
If you set up Stacker under DOS, you can add the Stacker program group to Windows. The Stacker group 
includes the Stacker Toolbox, Stacker Help, and the Readme document.

To create the Stacker program group
1. Open the Program Manager's File menu.
2. Choose Run.
3. In the Command Line field, type C:\STACKER\SGROUP (or use the Browse function to select it).

If your Stacker files are stored in a different directory, use the correct path.
4. When asked, confirm that you want to create a Stacker group.



Virtual Memory
Copyright    Novell, Inc. 1993. All rights reserved. Version 1.0

Use the Virtual Memory icon to view or change swap file settings. This dialog box allows you to install 
permanent swap files on Stacker drives. The swap file settings control how your system uses virtual 
memory.

Use this dialog box in the same way as the standard Control Panel -386 Enhanced- Virtual Memory dialog 
box. Using the standard Virtual Memory dialog box, you cannot create permanent swap files on Stacker 
drives.

Current Setting Area shows the drive, size, and type of the swap file currently being used.

When you choose the Change button, the Virtual Memory dialog box expands, displaying these 
additional settings.

Drive This option lists the disk drives on your computer and any network drives to which 
you are connected.

Type This option lists the types of swap files you can create, depending on the drive you 
have selected.

Space Available This value shows the total amount of space available (in KB) on the selected drive.
Maximum Size This value shows the maximum size for the permanent swap file.
Recommended Size This value shows the recommended value you should specify for a permanent 

swap file.
New Size Use this option to specify the size of your swap file.
Use 32-Bit Access Use this check box to turn 32-bit access on or off.



Virtual Memory Dialog Box
If you choose the Virtual Memory button from the Control Panel's '386 Enhanced icon, you can change 
your swap file settings in much the same way. However, you will not be able to create a permanent swap 
file on a Stacker drive.



Use 32-bit Access
Use this check box to turn 32-bit disk access on or off.

Select this check box if you only have a small amount of free memory and you want increased 
performance when you are using the DOS prompt.

When this box is selected, you can run more instances of the DOS Prompt and switch between 
them faster. If you have more than one instance of the DOS Prompt running and the applications 
running in them are all accessing disk drives, the access time is faster when using 32-bit disk 
access.

When you install Microsoft Windows, the Setup program checks to determine whether your hard disk 
controller is compatible with the 32-bit access feature. If it is compatible, the 32-bit Disk Access check box 
appears.



New Size
Use this option to specify the size of your swap file in KB.

Type a value.

If you are creating a permanent swap file, this is the amount of space on the selected disk that will be 
allocated to the file. If you are creating a temporary swap file, the swap file cannot grow to exceed this 
value.



Recommended Size
This value shows the recommended value you should specify for a permanent swap file to achieve the 
best performance. 

If you select Temporary as the swap file type, this information displays the recommended maximum size 
to which the temporary swap file should grow. This value reflects the most efficient use of your disk, 
based on the available disk space.

If you select None as the swap file type, this information does not appear in the dialog box.



Space Available
This value shows the total amount of space available (in KB) on the selected drive. If the selected drive is 
a Stacker drive, the value shown represents the estimated available space, which is always larger than 
the physical available space.



Maximum Size
This value shows the maximum size for the permanent swap file. This size is determined by the amount 
of contiguous disk space found on the selected drive. If the selected drive is a Stacker drive, then the 
value shows the size of the largest contiguous physical disk space.

If you select Temporary or None as the swap file type, this information does not appear in the box.



Type
This option lists the types of swap files you can create, depending on the drive you selected.

Open the list, and then select the type of swap file (Temporary, Permanent, or None) that you 
want to create.

Using a permanent swap file improves the speed of Windows because the swap file is contiguous and 
accessing it generally takes less time than accessing a non-contiguous temporary swap file. Because a 
permanent swap file must be contiguous, you cannot create a permanent swap file larger than the largest 
contiguous free block of space on your hard disk.

Depending on the type of swap file you select, the Maximum Size and Recommended Size values may or 
may not appear in the dialog box. For example, if you choose to create a temporary swap file on a 
network drive, Maximum Size does not appear.

Note that you cannot create a temporary swap file on a Stacker drive.



Drive
This option lists the standard hard disk drives and Stacker drives on your computer, as well as any 
network drives to which you are connected. The standard hard disks are labeled hard disk, Stacker drives 
are labeled Stacker, and network drives are labeled network.

Open the list, and then select the drive where you want the swap file to be located.

The available settings in the Type list and Size Box change, depending on whether you select a local disk 
or a network drive. For example, if you select a network drive, the Permanent setting used to create a 
permanent swap file is not available.



Swap file
A hidden file on a hard disk or network drive that Windows uses for swapping information from memory to 
the disk or drive. Stacker lets you store a permanent swap file on a Stacker drive.



Virtual Memory
The space on your hard disk or network drive that Microsoft Windows uses as if it were actually memory. 
Windows does this using swap files.
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Toolbox Help Contents
The Stacker Toolbox is your gateway to monitoring and maintaining your Stacker drives.

Toolbox Components For a visual overview of the Toolbox
Toolbox Gauges For details about all the gauges
Toolbox Tools For details about using Stacker's tools
Menu Commands For information about using the Toolbox commands

Full Help Contents For other information about Stacker

For Help on Using Help, press F1.



Toolbox Components
Double-click the help title bar so you can see the entire Stacker Toolbox. For more information about any 
part of the Toolbox, just click it.



Toolbox Gauges
The four Toolbox Gauges provide information at a glance.

Compression Ratio Gauge
Disk Space Gauge
Fragmentation Gauge
Backup Status Gauge



Compression Ratio Gauge Details
Click on parts of the gauge for more Information. When you double-click on the caption in the actual 
gauge, the gauge changes to show the extra bytes that Stacker has given you on this drive.

The compression ratio gauge shows how well your data compresses. Stacker analyzes the selected drive 
and calculates the actual compression ratio. The current expected compression ratio appears on the left 
of the gauge. 

For more information, click Setting Preferences



Compression Preferences
The Compression Preferences dialog lets you specify:
· How often (in seconds) Stacker should gather information and update the gauge
· What difference between the actual and expected compression ratios should trigger a warning
· Whether or not to show a visual alert
· Whether or not to use a sound alert, and which sound to use.

Update gauge every specifies the frequency of gauge update.

Enable warning flash lets the visual warning appear. A warning message will flash in the caption area 
of the gauge.

Warning at lets you specify the warning level. If you specify a Warning at 
10 percent, Stacker alerts you when the actual compression ratio exceeds the 
expected compression ratio by 10 percent or more.

Show warning every specifies the flash duration in seconds; the message flashes on and off at this 
interval.

You can also use the Light Bulb icon on the toolbar to activate or inactivate flashing warning messages.

Click this to suppress all flashing messages.

Click this to turn flashing messages on.

For information on using audible warnings, click Sound.



Disk Space Gauge Details
Click on parts of the gauge for more information.

To see more information about how your data compresses on the disk, click Disk Details.

The disk space gauge shows the amount of disk space used and free. Marks on the gauge show you 
where Stacker Territory begins and where Stacker will alert you when the disk starts getting full. Even 
when you minimize the Stacker Toolbox to an icon, it still displays dynamic disk space information.

As you use your computer, data fills the drive. When the data fills to the buffer zone you set, Stacker 
alerts you. 

For more information, click Setting Preferences



Disk Space Preferences
The Disk Space Preferences dialog lets you specify:
· How often (in seconds) Stacker should gather information and update the gauge
· How much free space should be set aside as a buffer. If the amount of free space becomes less than 

this, it should trigger a warning
· Whether or not to flash a warning message when the disk fills to the buffer you set
· Whether or not to use a sound alert, and which sound to use.

Update gauge every specifies the frequency of gauge update.

Enable warning flash lets the visual warning appear. The warning message will flash in the caption 
area of the gauge. 

Warning at lets you specify the warning level. If you specify a Warning at 10 percent free 
space, Stacker alerts you when 10 percent or less of the disk remains available 
for new data, or when more than 90 percent of the disk is full.

Show warning every specifies the flash duration in seconds; the message flashes on and off at this 
interval.

You can control the flash from the toolbar as well.

Click this to suppress all flashes.

Click this to turn flashes on.

For information on using audible warnings, click Sound.



Fragmentation Gauge Details
Click on parts of the gauge for more information.

The fragmentation gauge shows how fragmented the current drive is. When there aren't any large blocks 
of space left on your disk, DOS splits files and fits pieces into smaller spaces throughout the disk. When 
your drive becomes quite fragmented, file access slows as DOS locates and collects all the pieces of the 
file.

Generally, the more blocks on the Fragmentation gauge that are filled with color, the more fragmented 

your disk is. To remove fragmentation, use the  Optimize tool.

For more information, click Setting Preferences



Fragmentation Preferences
The Fragmentation Preferences dialog lets you specify:
· How often (in seconds) Stacker should gather information and update the gauge
· How much fragmentation on the disk should trigger a warning
· Whether or not to show a visual alert
· Whether or not to use a sound alert, and which sound to use.

Update gauge every specifies the frequency of gauge update.

Enable warning flash lets the visual warning appear. The warning message will flash in the caption 
area of the gauge.

Warning at lets you specify the warning level. If you specify a Warning at 10 percent, Stacker 
alerts you when the amount of fragmentation on the disk exceeds 10 percent. 

Show warning every specifies the flash duration in seconds; the message flashes on and off at this 
interval.

You can control the flash from the toolbar as well.

Click this to suppress all flashes.

Click this to turn flashes on.

For information on using audible warnings, click Sound.



Backup Status Gauge Details
Click on parts of the gauge for more information.

The backup status gauge shows how much of your disk has been backed up. Most backup procedures 
modify the archive attribute of the files. If your backup method doesn't modify the archive attribute, your 
backup status gauge won't show the disk's true status.

For more information, click Setting Preferences



Backup Status Preferences
The Backup Status Preferences dialog lets you specify:
· How often (in minutes) Stacker should gather information and update the gauge
· What percentage of files not backed up should trigger a warning (based on the archive attribute 

setting)
· Whether or not to show a visual alert
· Whether or not to use a sound alert, and which sound to use.

Update gauge every specifies the frequency of gauge update.

Enable warning flash lets the visual warning appear. The warning message will flash in the caption 
area of the gauge. 

Warning at lets you specify the warning level. If you specify a Warning at 30 percent, Stacker 
alerts you when 30 percent or more of your files have the archive attribute turned 
on. 

Show warning every specifies the flash duration in seconds; the message flashes on and off at this 
interval.

You can control the flash from the toolbar as well.

Click this to suppress all flashes.

Click this to turn flashes on.

For information on using audible warnings, click Sound.



Using Sound for Warnings
You can choose to have Stacker alert you by playing a sound when the Toolbox is open and a gauge 
reaches the level you set. For example, if you want to be notified when your Stacker drive is 90% full, 
Stacker can play a sound at the interval you choose. You can specify both the sound and the interval. 

Note: You can only enable sound if your system has a sound card that supports Windows .WAV files or a 
driver that allows your computer's speaker to play .WAV files.

To have Stacker play a sound
· Your computer configuration must be capable of playing a sound.
· Check the Enable Sound field in the Preferences dialog box.
· Do not turn off the sound button in the Toolbar.

To specify which sound
· Use the Browse button to choose a WAV file. Stacker provides a few sounds. Your Windows directory 

also contains a few. 
· Use the Test button to see which one you like.

You can control the sound from the toolbar as well.

Click this to suppress all sound.

Click this to turn sound on.



Toolbox Tools
Click the tool or its icon:

Compress a disk

Check a Stacker drive

Show compression information 

Optimize a Stacker drive

Tune the compression level

Change password protection

Save control information

Change Stacker drive size or Windows swap file settings

View disk compression details

Suppress warning sound



Suppress warning flash



Menu Commands

Settings
Select Drive
Update 
Preferences
Exit

Options
Drive Bar
Tool Bar
Status Bar
Compression Ratio
Disk Space
Fragmentation
Backup Status

Tools
Compress Disk
Uncompress Disk
Recompress Disk
Check Integrity
Stacker Report
Optimize ... 
Tune Stacker ...
Password Protection ...
Autosave ...
Configure ... 
Disk Details



Select Drive

Use this command to choose a different drive for Toolbox display. You can choose a drive by clicking in 
the Drive Bar as well.



Update

Use this command to update information in the disk space, fragmentation, and backup status gauges. 
Stacker will take a few moments to gather the information. Then Stacker resumes gathering information 
according to the value set on the Preferences screen for each gauge.



Preferences

Choose Preferences to specify the warning level for any gauge as well as how often Stacker should 
check the Stacker drive for new information.

· Specify how often to gather information in the Update gauge field.
· Specify the warning level in the Warning box.
· To cause a flashing warning message, check Enable Warning Flash.
· Specify the sound to use in the Sound box.
· To cause a repeating sound, check Enable Sound.

For more information on preferences for a particular gauge:
Compression Ratio
Disk Space
Fragmentation
Backup Status

For information on using audible warnings for any gauge, click Sound.



Exit

Use this command to exit the Toolbox. You won't see or hear any warnings while the Toolbox is closed.



Drive Bar

Use this option to control the display of the drive bar in the Toolbox. If the option is checked, the drive bar 
displays. If no check appears, you won't see the drive bar. 

To choose a different drive when the drive bar doesn't display, pull down the Settings menu and choose 
Select Drive.



Toolbar

Use this option to control the display of the Toolbar in the Toolbox. If the option is checked, the Toolbar 
displays. If no check appears, you won't see the Toolbar. 

To choose a tool when the Toolbar doesn't display, use the Tools menu.



Status Bar

Use this option to control the display of the Status bar in the Toolbox. If the option is checked, the Status 
bar displays. If the command is not checked, the Status bar is not displayed. 



 Compress a Disk

Use this tool to compress a disk. You can choose to run Stacker Setup or to create an empty Stacker 
drive quickly using the free space on a disk. Compress is available only when the current disk is not 
compressed.

If an empty removable disk is current, choosing Compress a Disk automatically creates an empty Stacker 
drive on that disk. If any other disk is currently, you'll be able to choose the disk to be compressed and 
any Custom Setup features.

Show me the complete procedure.



Recompress a Disk

Use this tool to recompress all the data on a Stacker drive. It is equivalent to optimization using the Full-
MaxSpace method. This process gives you maximum compression. Stacker even resets internal 
compression ratios to give you the most accurate space reporting possible.

Show me the complete procedure. 



Uncompress a Stacker Drive

This tool is available only from the Tools menu. Use it if you want to remove Stacker compression from a 
disk without losing any of your data. 

Your disk must have enough space available to hold the data in its uncompressed form. If it doesn't, you'll 
be told how much more space you need.

Show me the complete procedure.



Uncompress Exit

Stacker cannot uncompress a Stacker drive while it is in Windows. Stacker has to leave Windows 
completely before starting to uncompress the disk. If you have any open applications or unsaved files, 
choose Cancel now and close your files. Then choose the Uncompress tool again.

When Stacker has completed the procedure, it returns you to your normal Windows setup.



 Check a Stacker Drive

Use this tool to make sure your Stacker drive is in good condition. You should check your disks regularly 
to identify and repair small problems before they become big ones that can put your data at risk.

The Check tool examines the entire Stacker drive looking for data and structure integrity problems. In the 
process, it detects and reports on the space used and free on the disk. Check cannot make repairs while 
running under Windows, however.

If it detects any problems, Check tells you what to do next. You'll probably have to exit Windows and 
check the drive integrity from the Stacker DOS Toolbox.

Show me the complete procedure.



 Stacker Compression Report

Use this tool to see how the different types of files compress on your disk. It gives you the same 
information as choosing All Files from the Stacker menu in the File Manager.

The report groups all files on the disk according to extension. Each line shows a single extension (Type), 
how many files have that extension (Count), how much space those files occupy (Bytes) and how well 
they compress (Comp. Ratio). Just click the button at the head of a column to sort by that value. 

When you choose , Stacker gathers fresh information from the current disk. It is always up to 
date, showing the current status of the disk.

Show me the complete procedure.



 Optimize a Stacker Drive

Use this tool to improve the speed or compression performance of a Stacker drive. You can defragment 
the drive or recompress the data as well.

The optimization methods you can choose from are:
Quick Defragments all files, but leaves free space scattered throughout the disk.
Full Defragments all files and puts all the free space at one end of the disk.
Full-MaxSpace Recompresses all files as it fully defragments the disk. Then Stacker adjusts your 

expected compression ratio to closely match the amount of compression on the disk.

Show me the complete procedure.



 Tune Compression/Speed Balance

Use this tool to adjust the balance of compression and speed for your computer. Stacker always uses 
maximum compression (MaxSpace) during Setup or when recompressing a disk. By default, Stacker 
leaves the setting for maximum compression during use. 

If you have an older, slower, computer system, you may want to increase the speed (MaxSpeed) and give 
up a bit of the compression advantage.

Show me the complete procedure.



Password Protection

Use this tool to provide password security for your Stacker drives. Once a password is assigned, any user 
must enter the password before Stacker will mount the drive. Stacker passwords are especially useful for 
compressed floppies or other removables; you can take "Stacker Anywhere" and be sure your data is 
secure.

You can protect any Stacker drive with a password. There are two types of passwords:
· A read/write password -- anyone knowing the password has full access to the drive.
· A read-only password    -- anyone knowing the password can read information but can't make 

changes or delete files. A Stacker drive must already have a read/write password assigned before it 
can have a read-only password. You'll see the Read Only field if the disk already has a read/write 
password. Just check this field to work with a read-only password.

Important! If you assign a password, be sure not to forget it.

Stacker passwords are not case sensitive. They can be from one to eight characters long and use any 
characters except these:

; \" / < > | {Space} and {Tab}.

Setting a Password
Changing a Password
Removing a Password
Passwords for non-U.S. keyboards



Passwords for non-U.S. Keyboards

Many international keyboards have accented characters or characters located in positions different from a 
U.S. keyboard. Do not use these characters to password-protect a Stacker drive mounted at boot time. 
Stacker will not recognize the password, and you will not be able to access your data.

An appendix in your DOS manual has keyboard illustrations that show how characters change location 
from one language to another. Use these illustrations to compare your keyboard to the U.S. keyboard. 
Create your password with only the characters on your keyboard that directly correspond to the U.S. 
characters' locations. In general, do not create a password using a character generated by the Shift, Alt or 
Alt Gr keys.



Removing a Password

If you choose Remove Password, Stacker gives you the Remove Password dialog. If you want to remove 
a read-only password, be sure to check the Read Only field. You type the password just once. If you type 
the correct password, Stacker removes it. (If not, you see an error message.) You can then apply another 
or return to the Toolbox.

Show me the complete procedure.



Changing a Password

If you choose Set Password when a Stacker drive already has one, you'll be able to change the current 
password. If you want to change a read-only password, be sure to check the Read Only field.

Show me the complete procedure.



Setting a Password

When you choose Set Password, Stacker lets you set a password if the drive doesn't have one, or 
change it if it does. If the Stacker drive has a read/write password, the Read Only field is available; check 
it if you want to set, change, or remove a read-only password. 

Stacker lets you type and verify the new password before putting it into effect. 

Show me the complete procedure.



 AutoSave

Every time you start up your computer, Stacker saves the header for each Stacker drive. If you want, you 
can set up AutoSave to check your Stacker drives regularly when the Toolbox is open and save updated 
header information. Use this tool to turn AutoSave on or off or to change Stacker's AutoSave settings so it 
works on a different time schedule.

After you turn on AutoSave, it works in the background, while your computer is idle. AutoSave works only 
after there has been no keyboard or mouse activity for five minutes. When the time comes for saving a 
header, AutoSave makes sure the computer isn't in use, and then checks out the drive and saves a 
header. If you use the computer during this time, AutoSave stops immediately, giving you full access to 
your computer. When the computer is idle again, AutoSave resumes. Once AutoSave has saved a 
header, you can be sure that it has checked out your Stacker drive to make sure the drive is in good 
condition.

Show me the complete procedure.



 Configure Tool

The Configure tool lets you make either of two major changes to the way your system is configured. 

· Change Stacker drive size lets you make more space on the Stacker drive or its uncompressed drive.
· Change swap file settings lets you modify how and where the Windows swap file is located.



Change Stacker Drive Size

Use this tool to make a Stacker drive larger or smaller. The compressed Stacker drive is a STACVOL file 
residing on an uncompressed disk. If you make the Stacker drive larger, it takes up more space on the 
uncompressed disk. If you make more uncompressed space available, the Stacker drive gets smaller.

Show me the complete procedure.



Change Swap File Settings

Use this tool to examine or change the location or type of Windows swap file you have. Stacker lets you 
store a permanent swap file on a Stacker drive, then keeps it uncompressed for you so Windows can use 
it effectively.

You can also control the swap file settings through the Virtual Memory icon in the Control Panel. Just 
double-click on the icon. The process is the same as through the Toolbox.

Show me how.



 Disk Details

The Disk Details display shows you how different types of data on your disk compress. The  area on 
the right represents free space on the disk.

· Precompressed files are already tightly compressed; Stacker can't do much with them.
· Programs are fairly tightly compressed; Stacker can compress them some, but not a lot.
· Data consists of text files, spreadsheets, databases, and the like. Stacker compresses data files 

exceptionally well.

Click on screen areas below for more details.

Each line below the chart shows information about one category of files. The "Bytes Available" value 
shows how much more data would fit on the disk if you were to fill it with only that type of data. The 
bottom line ("Average") shows how much more data you can fit on the disk if you continue with a mix of 
files similar to the current disk.



Light Bulb Icon
This icon lets you turn on or off flashing warnings for the Stacker Toolbox gauges. For each gauge, you 
can set a threshold level on its Preferences screen (double-click the gauge to access its Preferences 
screen). For example, for the Disk Space gauge, you might specify that you want to be alerted when your 
disk reaches 90 percent full. 

When the light bulb is on, warning messages will flash to alert you whenever a gauge's threshold is met. If 
you click the "not" icon, no warning messages will flash.



Sound Icon
This icon lets you turn on or off audible warnings for the Stacker Toolbox gauges. For each gauge, you 
can set a threshold level on its Preferences screen (double-click the gauge to access its Preferences 
screen). For example, for the Disk Space gauge, you might specify that you want to be alerted when your 
disk reaches 90 percent full. 

When the sound icon is on, a sound will play to alert you whenever a gauge's threshold is met. If you click 
the "not" icon, no audible warnings will sound.



Details Icon
Clicking this tool brings you an overview of compression on the selected disk. You can see how your data 
files compress compared to your precompressed and program files. You can also easily estimate how 
much more will fit on your Stacker drive.

The information also shows how much data of the specified type you can add to your disk. The disk will 
hold more than that if you add just data files. It will hold less, of course, if you add only precompressed 
data or programs. 



Compression Ratio Gauge
This gauge shows the compression status of the disk. The left upper value on the scale is the current 
expected compression ratio. The value in the slider on the right is the actual compression ratio of your 
data. Stacker automatically adjusts the expected compression ratio when it compresses or recompresses 
data on a disk. 

To see this information in terms of extra bytes provided by Stacker, double-click on the "Compression 
Ratio" caption in the actual Toolbox.



Disk Space Gauge
This gauge shows how full your disk is. The red triangle shows the beginning of Stacker Territory; any 
space to the right of this is a gift from Stacker. The red line near the right end of the gauge shows the 
point at which you'll be warned that the disk is almost full.



Fragmentation Gauge
This gauge shows how much fragmentation is currently found on your disk. You can use the Optimize tool 
to defragment your data and improve the performance of your Stacker drive.



Backup Status Gauge
This gauge shows how much of your data has been backed up since it was created or modified. It is 
based on the DOS archive attribute for the file.



Compress Icon
This tool lets you create any type of Stacker drive. You can quickly create an empty Stacker drive using 
an empty removable drive or run Setup to have all Stacker's options available. Compress is available only 
when an uncompressed disk is selected.



Check Icon
This tool examines the status of the currently selected Stacker drive. If it detects any problems, the 
messages tell you what to do.



Report Icon
This tool brings you information about file compression on the current Stacker drive. This is the same 
information you see after choosing All Files on the Stacker menu in File Manager.



Optimize Icon
This tool can fully optimize your disk or do a quick version, defragmenting files but leaving free space 
scattered on the disk. Once you choose Optimize, you can choose Full-MaxSpace to recompress data in 
the process of doing a full optimization or to complete the process of converting other compressed disks 
to Stacker quality.



Tune Icon
This tool lets you modify the balance between the amount of compression and the time it takes to achieve 
compression. If you set it for MaxSpace, you get full benefit of Stacker's newest compression technology. 
Stacker always uses MaxSpace when it compresses or recompresses a disk.



Password Icon
This tool lets you set, change, or delete a password to protect a Stacker drive from unauthorized access 
or changes.



AutoSave Icon
This tool lets you control how often Stacker saves control header information. You may need the saved 
information if the data on your Stacker drive becomes unavailable.



Configure Icon
This tool lets you tailor your Stacker configuration for your situation. You can change the Stacker drive 
size to get more compressed or uncompressed space. Or, you can change how your Windows swap file 
is handled and stored.



Toolbar 
The Toolbar displays the tools you can use to monitor and manage your Stacker drives. When the mouse 
pointer is over a tool icon, the status bar shows what it does. The Options menu lets you display or 
remove the Toolbar.



Drive Bar 
The Drive bar shows all the disk drives attached to your system. When the mouse pointer is over a drive 
icon, the status bar shows the drive letter and type. The Options menu lets you display or remove the 
Drive bar.



Status Bar
This area shows the current location of the mouse pointer in the Toolbox. The Status bar contains the 
name and type of disk if the pointer is in the Drive bar, the function of the icon if the pointer is in the 
Toolbar, or the effect of the gauge if the pointer is over one of them.



Menu Bar
This area shows the menu names. The menus work just like all the other menus in Windows.



Unable To Exit Windows
Stacker must leave Windows completely to use the tool you requested. You will have to close your open 
programs before it can continue.

When Stacker has finished, it returns you to your normal Windows setup



Exit Windows

To use the tool you chose, Stacker has to leave Windows and optimize your Stacker drive under DOS. 
When it has finished, Stacker will return you to your normal Windows setup.

If you have any open applications or unsaved documents, you might want to choose Cancel and save 
your data before continuing with this procedure.



Tuning Stacker
You can tune Stacker so it always gets the very best compression (MaxSpace) or so that it works as fast 
as possible (MaxSpeed) or anywhere in between.

MaxSpace gives you maximum compression

MaxSpeed gives you the most speed

To tune Stacker
1. From the Stacker Windows Toolbox, select any drive.
2. Choose the Tune tool.
3. Set the slider at the desired location. You can click on MaxSpace or MaxSpeed, drag the slider to the 

level you want, or just click on the level you want.
4. Choose OK.



Optimizing a Disk
When Stacker optimizes a disk, it reduces fragmentation on it. The three optimization methods are Quick, 
Full, and Full-MaxSpace.

To optimize a Stacker drive
1. From the Stacker Windows Toolbox, select the drive.
2. Choose the Optimize tool.
3. Choose Quick, Full, or Full-MaxSpace, then click OK.
4. Choose OK to leave Windows so the Stacker Optimizer can complete its work.

The Optimizer displays a drive map that keeps you posted on the optimization phases. When it is 
finished, Stacker prompts you to press a key to return to Windows.



Monitoring File Compression
You can monitor file compression through the File Manager's Stacker menu and through the Stacker 
Toolbox gauges.

To use the File Manager's Stacker menu
1. Open the File Manager.
2. Choose a Stacker drive.

To see individual file or directory compression ratios
1. Select the files and/or directories in the right side of the File Manager window.
2. From the Stacker menu, choose Selected Files.
3. After examining the display, choose OK.

To see Stacker Report of all the files on the disk
1. From the Stacker menu, choose All Files.
2. After examining the display, choose OK.

To see a summary of compression on the disk
1. From the Stacker menu, choose Disk Summary.
2. After examining the display, choose OK.

To use the Stacker Windows Toolbox
· In the Stacker program group, double-click the Toolbox icon.

or
· In the File Manager, select your Stacker directory, then double-click STACWIN.EXE.

For assistance in interpreting the gauges, press F1 when the Stacker Toolbox is active.



Compressing a Floppy Disk
You can compress an empty floppy disk or compress data currently on a floppy disk.

To compress an empty floppy or other removable disk
1. Insert the empty disk into the disk drive.
2. From the Stacker Windows Toolbox, select that removable drive.
3. Choose the Compress tool.
4. Click OK to let Stacker create and verify the drive.
5. Click OK after the disk is created.

To compress data on a floppy disk
1. Insert the floppy disk containing data to be compressed into a floppy drive.
2. In the Stacker Toolbox, choose any uncompressed drive except for an empty removable drive.
3. Choose the Compress tool.
4. When Setup starts, choose the disk to be compressed and proceed as in Custom setup.



Checking Integrity of Stacker Drive
Stacker can check the integrity of Stacker drives within Windows and report on the status. Any problems 
must be repaired using the Stacker DOS Toolbox.

To check the integrity of a Stacker drive
1. From the Stacker Toolbox, select the drive.
2. Choose the Check tool.

Stacker leaves Windows briefly to check the Stacker structures on the disk. If it detects any problems, it 
tells you what to do next. If it doesn't find anything wrong, you return immediately to Windows.



Checking and Repairing a Stacker Drive
Stacker cannot repair a Stacker drive under Windows. You'll have to exit Windows completely and use the 
Stacker DOS Toolbox.

To repair a Stacker drive using the Stacker DOS Toolbox
1. Exit Windows completely.
2. Type STAC to open the Stacker DOS Toolbox.
3. Use the up or down arrow to highlight Check Drive Integrity, and then press ENTER.
4. If asked, choose the Stacker drive to check.
5. Follow the instructions on the screen. If Check asks if it should make repairs or do a surface test, let 

it.



Changing Warning Level for Toolbox Gauges
While the details differ for the different toolbox gauges, the procedure for changing the warning level and 
use of flashing or sound as warnings is the same for all.

To change the warning level
1. From the Stacker Toolbox, double-click the gauge (or choose Preferences from the Settings menu 

and click the gauge button to be affected).
2. In the Warning at field, type the desired level. The units are appropriate for the gauge.
3. Choose OK.



Deleting Passwords
Stacker drives can use password protection.

To delete an existing Stacker drive password
1. From the Stacker toolbox, select the drive.
2. Choose the Password tool.
3. To remove a read-only password, check the Read Only field.
4. Click Remove Password.
5. Type the existing password in the field.

If you type it correctly, the password is removed. If not, you'll have to start over.



Defining Passwords
Stacker drives can use password protection.

To define a password for a Stacker drive
1. From the Stacker toolbox, select the drive.
2. Choose the Password tool.
3. To define a read-only password, check the Read Only field.

Note: This field is available only if the disk already has a read/write password.
4. Click Set Password.
5. Type the desired password in the Type new password field
6. Type the password again in the Verify new password.
7. Click OK.
8. Click OK again if you are finished using the Password feature.



Changing Passwords
Stacker drives can use password protection.

To change a password for a Stacker drive
1. From the Stacker toolbox, select the drive.
2. Choose the Password tool.
3. To change a read-only password, check the Read Only field.

Note: This field is available only if the disk already has a read/write password.
4. Click Set Password.
5. Type the existing password in the Type old password field.
6. Type the desired password in the Type new password field
7. Type the password again in the Verify new password.
8. Click OK.
9. Click OK again if you are finished using the Password feature.



Changing AutoSave Settings
Stacker AutoSave saves the header information from all your Stacker drives while your computer is idle. 
For each Stacker drive, you can change the frequency or time of the AutoSave and control what you see 
as you use Windows. By default, Stacker AutoSave runs invisibly. If you like, you can have it display its 
icon on the desktop. Just click Run AutoSave Invisibly to remove the check.

Once AutoSave is enabled for a drive, Stacker AutoSave can use its default settings (displayed in the 
AutoSave Configuration dialog box). If you prefer, you can configure the settings for each Stacker drive 
individually.

To change AutoSave headings
1. From the Stacker Windows Toolbox, select the Stacker drive.
2. Choose the AutoSave tool.
3. To enable AutoSave for that drive, check Enable AutoSave.
4. To change the interval, click Interval, then type or select how often Stacker should save headers.
5. To schedule AutoSave for a particular time, click Scheduled, then type or select the time of the 

scheduled AutoSave.
6. To make the current setting the default, click Set As Defaults.
7. To change the settings to the current default, click Use Defaults.
8. To let Stacker AutoSave interrupt processing to display any problems, check Enable Warning 

Messages.
9. To display the Stacker AutoSave icon continuously, uncheck Run AutoSave Invisibly.



Recompressing a Disk
When Stacker recompresses a disk, it does a full optimization, rewriting all data in the process so that it 
gets the best compression possible. Stacker then adjusts the expected compression ratio to be in keeping 
with the type of compression your data can actually achieve. The Full-MaxSpace method of optimization 
achieves recompression.

To recompress a Stacker drive
1. From the Stacker Windows Toolbox, select the drive.
2. Choose the Optimize tool.
3. Choose Full-MaxSpace, then click OK.
4. Choose OK to leave Windows so the Stacker Optimizer can complete its work.

The Optimizer displays a drive map that keeps you posted on the optimization phases. When it is 
finished, Stacker prompts you to press a key to return to Windows.

You will notice that the expected compression ratio (at the top of the scale on the left in the Compression 
Ratio gauge) has a new value.



Uncompressing a Disk
Stacker can uncompress all the data on a disk if the Stacker drive (or its uncompressed drive) has 
enough free space. There is no icon on the Toolbar, but you can use the Tools menu.

To uncompress a Stacker drive
1. From the Stacker Windows Toolbox, select the drive.
2. From the Tools menu, choose Uncompress disk.
3. Choose OK to leave Windows. 

Stacker will probably have to fully optimize the drive before it can be sure there is enough room to 
uncompress the data. If it needs more space, Stacker tells you how much more you need.



Warning Level
This mark indicates where the visible or audible alert will occur. When the disk contains this much data, 
you will see or hear any warnings that are enabled when the Toolbox is open.



Beginning of Stacker Territory
This triangle indicates where the extra bytes provided by Stacker begin.



To Set Preferences
Double-click anywhere on the gauge to get to the Preferences dialog for that gauge. You can set the 
warning levels and the sounds on that dialog box.

Note: You can only enable sound if your system has a sound card that supports Windows .WAV files or a 
driver that allows your computer's speaker to play .WAV files.



Percent of Files to Back Up 
This value shows the percentage of data on your Stacker drive that is not backed up. The Toolbox uses 
the archive attribute to determine if a file is backed up, so if you use a backup method that doesn't alter 
the archive attribute, this value might not match your system.



Fragmentation Indicator
Each block of color indicates more fragmentation. The actual colors don't make any difference.



Level of Fragmentation
Level and percentage of fragmentation on the Stacker drive. If it shows Medium or High, you might want 
to use the Optimize tool to defragment the drive.



Free on Disk
The amount of space still unused on the Stacker drive. You can store additional compressed data here.



Used on Disk
The amount of space on the Stacker drive currently used for storing files.



Disk Space Used
The percent of the Stacker drive currently filled with files.



No Compression
Compression of 1.0:1 is no compression. Without Stacker, you get zero (0) extra bytes.



Actual Compression
How all your data compresses, on the average. The Extra Bytes part of the gauge shows you how many 
extra megabytes Stacker gave you so far.



Expected Compression
The current expected compression ratio. Stacker automatically adjusts this value when it compresses or 
recompresses a disk. The Extra Bytes part of the gauge shows you how many extra megabytes Stacker 
will provide if your data compresses as expected.



Caption
Double-click here to see the same compression information in terms of extra bytes that Stacker provides. 
Double-clicking on Extra Bytes returns you to the standard compression ratio gauge.



Mouse Pointer
Image of pointer.



Data File Information

This line summarizes the  data files on your Stacker drive. It shows how much of the disk is Used, the 
Compression achieved by those files, and how many Bytes Available you have for storing additional data 
files.



Program File Information

This line summarizes the  programs on your Stacker drive. It shows how much of the disk is Used, the 
Compression achieved by those files, and how many Bytes Available you have for storing additional 
programs.



Precompressed File Information

This line summarizes the 
 precompressed files on your Stacker drive. It shows how much of the disk is Used, the Compression 
achieved by those files, and how many Bytes Available you have for storing additional precompressed 
files.



Average Information
This line summarizes the status of all files on your Stacker drive. It shows the average Compression of all 
files on the disk and how many Bytes Available you have for storing additional files if you maintain the 
same general mix of file types.



Precompressed

This part of the chart  represents precompressed files. These files are already as compressed as 
they can get.



Programs

This part of the chart  represents program files.



Data

This part of the chart  represents data files, such as documents, spreadsheets, databases, and 
graphics.



Free Space

This part of the chart  represents free space on your disk.



Not Backed Up Data
This part of the diagram represents files that have not been backed up.



Backed Up Data
This part of the diagram represents files that are backed up.



Not Enough Memory
You do not have enough memory to run the current application. Close some of your other applications or 
restart Windows and try the operation again.



Error Calculating Fragmentation
This message can occur at startup, when you change drives, or when you choose Update from the 
Settings menu. 

Either an internal error occurred or the File Allocation Table (FAT), which contains pointers to the location 
of your files, was corrupted.

Restart Windows. If the same message occurs, use a surface scan utility to repair your disk.



Disk Space Error
The Toolbox was unable to obtain information about the selected drive. You could be attempting to read a 
floppy drive (with no disk in the drive), an invalid drive letter, or a network drive.

If it is a floppy drive, place the disk in the drive and retry. Otherwise, change the Toolbox to read a drive 
that is available.



Old Driver Error
You are attempting to run the Toolbox with a previous version of Stacker installed. The Toolbox requires a 
current Stacker for Windows & DOS driver in order to obtain the necessary information needed for the 
Compression Ratio and Fragmentation gauges. The Toolbox runs without a current driver, but only the 
Disk Space gauge updates.

Upgrade to the current version of Stacker for Windows & DOS. 



Stacker Not Running
You can't use Stacker Tuner because Stacker isn't running on your system. If you want to use Stacker 
Tuner, you'll have to set up Stacker on your computer.

To install Stacker for Windows & DOS on your system
1. Insert the Stacker installation disk and change to that drive or directory.
2. From the Program Manager's File menu, choose Run.
3. In the Command Line field, type SETUP.
4. Choose OK

Follow the on-screen instructions to set up Stacker.



Stacker Tuner Requires 3.1
You started Stacker Tuner, but an earlier version of Stacker is currently on your system. You have parts of 
two different versions of Stacker active in your system. This version of Stacker Tuner requires Stacker 3.0 
or later.

To install Stacker for Windows & DOS on your system
1 Insert the Stacker installation disk and change to that drive or directory.
2 From the Program Manager's File menu, choose Run.
3 In the Command Line field, type SETUP or SETUP.
4 Choose OK

Follow the on-screen instructions to set up Stacker.



Could Not Modify STACKER.INI
Stacker Tuner has to change the STACKER.INI file to put the tuning change into effect. It wasn't able to 
modify the file.

The disk may be full.



Could Not Determine Boot Drive
You started Stacker Tuner, but it cannot determine which drive is the boot drive.

Run a surface scan disk utility such as PC Tools to find out if there is a problem with your boot drive.



Could Not Open STACKER.INI
Stacker Tuner was not able to open your STACKER.INI file. This problem may be caused by a media 
defect on the disk itself. 

Leave Windows, then run the Stacker DOS Toolbox to check the disk integrity and do a surface scan. Let 
Check fix any errors it finds. 

To do a surface scan
1 Type STAC and press ENTER.
2 Choose Check Drive Integrity.
3 Follow the instructions on the screen. When asked if CHECK should do a surface scan, type Y and 

press ENTER.
4 After restarting Windows and opening the Stacker Windows Toolbox, click the Tune tool again.

If the problem recurs, try running a disk repair utility on the uncompressed drive or contact Stac's Product 
Support Services for assistance.



Stacker Tuner Cannot Run With DoubleSpace
You started Stacker Tuner, but DoubleSpace is on your system. You must install Stacker, removing 
DoubleSpace in the process, before you can tune Stacker.



Could Not Modify CONFIG.SYS
Stacker Tuner has to change the CONFIG.SYS file to put the tuning change into effect. It wasn't able to 
modify the file.

The disk may be full.



Could Not Open CONFIG.SYS
Stacker Tuner was not able to open your CONFIG.SYS file. This problem may be caused by a media 
defect on the disk itself. 

Leave Windows, then run the Stacker DOS Toolbox to check the disk integrity and do a surface scan. Let 
Check fix any errors it finds. 

To do a surface scan
1 Type STAC and press ENTER.
2 Choose Check Drive Integrity.
3 Follow the instructions on the screen. When asked if CHECK should do a surface scan, type Y and 

press ENTER.
4 After restarting Windows and opening the Stacker Windows Toolbox, click the Tune tool again.

If the problem recurs, try running a disk repair utility on the uncompressed drive or contact Stac's Product 
Support Services for assistance.



Could Not Create Temporary File
Stacker Tuner has to create a temporary file as it works, but it wasn't able to. Most likely, your disk is too 
full. You may have old files that you don't need any longer. Or you may be able to move some files to 
another disk.

To check how full your boot drive is
1 Open the File Manager.
2 Open a window for drive C (or your boot drive).
3 Notice how much space is available (on the bottom line of the File Manager window). Any value less 

than 20 KB may cause a problem.
4 If necessary, delete or move files (highlight the filename, then use Move or Delete from the File menu.
5 Choose OK.
6 Then click the Tune tool in the Stacker Toolbox again.



Could Not Write to Temporary File
Stacker Tuner has to write to a temporary file as it works, but it wasn't able to. Most likely, your disk is too 
full. You may have old files that you don't need any longer. Or you may be able to move some files to 
another disk.

To check how full your boot drive is
1 Open the File Manager.
2 Open a window for drive C (or your boot drive).
3 Notice how much space is available (on the bottom line of the File Manager window). Any value less 

than 20 KB may cause a problem.
4 If necessary, delete or move files (highlight the filename, then use Move or Delete from the File menu.
5 Choose OK.
6 Then click the Tune tool in the Stacker Toolbox again.

Stacker write-protects a disk when it senses a possibility of losing data. 

To remove write-protection (and fix the problem)
1 Leave Windows completely.
2 Type STAC and press ENTER.
3 Choose Check Drive Integrity.
4 Follow the instructions given by CHECK to correct the problem.
5 After restarting Windows and opening the Stacker Windows Toolbox, click the Tune tool again.



Could Not Back Up the CONFIG.SYS File
Stacker Tuner backs up the CONFIG.SYS file as CONFIG._BK before it modifies it. It couldn't back the 
file up for some reason. Most likely the disk is full or CONFIG._BK is a read-only file. Use File Manager to 
check how full the boot drive is. If it is close to full, make some space available by deleting or moving 
files. 

To find out if the CONFIG._BK file is read-only
1 In File Manager, display the root directory of the boot drive.
2 Highlight the CONFIG._BK filename.
3 On the File menu, choose Properties.
4 Notice the status of the Read-Only attribute. If it's checked, the file is read-only. Click the field to 

remove the check.
5 Choose OK.

If the disk is too full, you may have old files that you don't need any longer. Or you may be able to move 
some files to another disk. 

To check how full your boot drive is
1 Open the File Manager.
2 Open a window for drive C (or your boot drive).
3 Notice how much space is available (on the bottom line of the File Manager window). Any value less 

than 20 KB may cause a problem.
4 If necessary, delete or move files. (Highlight the filename, then use Move or Delete from the File 

menu.)
5 Choose OK.
6 Then click the Tune tool in the Stacker Toolbox again.



File Manager Extensions Help Index

You can get detailed information about these topics:

Disk Summary
All Files
Selected Files

Full Stacker Help

For Help on Help, Press F1



Disk Summary
From the Stacker menu in the File Manager, Disk Summary gives compression information about the 
entire Stacker drive. The graphic represents your disk divided into free space and used space.

Disk Information also provides
· Number of kilobytes free.

· Expected compression ratio is used to project the amount of free space.
· Number of kilobytes used.
· Actual compression ratio is used to determine the amount of used space.



All Files
From the Stacker menu in the File Manager, All Files displays the full Stacker Report, gathering 
information on all the files that share each extension represented on the disk. Each line represents one 
extension; it shows how many files are represented, how much space they occupy on the disk, and their 
average compression ratio. You can sort by any column; just click the button at the top of the list.

The display also shows how many directories and files are stored on the disk and how many extra bytes 
Stacker provides in storing them.

See Sorting the Full Stacker Report and Sort Order for more information.



Selected Files

From the Stacker menu in the File Manager, Selected Files gives compression information about the 
currently selected files and directories on a Stacker drive. You can sort the listing by name, type, size, or 
compression ratio. To sort, click the button that serves as the heading you want to sort by. For example, to 
sort the list by extension, click the Type button.

Selected Files also displays the compression ratio for the files in the list, their total size in bytes, and extra 
bytes Stacker provides by compressing those files.

See Sorting Selected Files and Sort Order for more information.



Sorting Selected Files
Sort the list by clicking one of the heading buttons at the top of the list. You can select and deselect sort 
categories by clicking different headings. Reverse the sort order by using the sort order options. There 
are four sort headings:

sorts alphabetically by file name.

sorts alphabetically by file name extension.

sorts numerically by size.

sorts numerically by compression ratio  .  



Sorting the Full Stacker Report
Sort the full list by clicking one of the heading buttons at the top of the list. You can select and deselect a 
sort category by clicking different headings. Reverse the sort order by using the sort order options. There 
are four sort headings:

sorts alphabetically by file name extension.

sorts numerically by how many files have that extension.

sorts numerically by how many bytes on disk those files occupy.

sorts numerically by compression ratio.



Sort Order
Choose to sort in Ascending or Descending order. For alphabetical sorts, Ascending sorts from 'A to Z.' 
Descending sorts from 'Z to A.' For numerical sorts, Ascending sorts '1,2,3. . .' Descending sorts '3,2,1. . .'



Working Drive
The uncompressed drive from which Stacker Setup creates a new Stacker drive.



CONFIG.SYS File
File used to configure many aspects of DOS. When you start up your computer, compression is 
preloaded, if possible, before the CONFIG.SYS file is processed.



DOS Protected Mode Services
DPMS is a way of accessing extended memory. It uses protected mode so that DOS can use it safely. 
Stacker includes a DPMS driver furnished by Novell.



MaxSpace
The method of compressing data on Stacker drives that results in the best compression for your system.



MaxSpeed
The tuning choice that gives your system the best speed; however, your data will not compress to the 
maximum. (For best compression, choose MaxSpace.)



Precompressed Files
Files on your disk that is compressed without using Stacker. Stacker can't compress these files any more. 



Stacker SmartPack
A compression technique that tightly packs files into spaces on your disk that even DOS can't access 
without Stacker's help.



Stacker DOS Toolbox
A toolbox that runs under DOS (when you type STAC at a DOS prompt outside of Windows). It includes 
those tools that are appropriate in a nonWindows environment.



Stacker Windows Toolbox
Your gateway to Stacker drive performance. It includes all the tools most users ever need, in addition to 
gauges and alert mechanisms you can use to monitor your Stacker drives.



Fragmentation
The scattering of "bits and pieces" of the same disk file over different areas of your disk. When you 
originally save your files, DOS organizes them and writes them to disk. While DOS attempts to write them 
in sequential order, sometimes it can't. As disks and files get used more often, contiguous space on the 
hard disk becomes scarce. Fragmentation can slow disk access and overall system performance.



Optimizing
The process of producing more efficient storage of files on your disk. Optimizing defragments and 
reorganizes files so they are located in a contiguous area. That way, when you read a file from disk, DOS 
only has to go to one place to find the file, instead of gathering all the file's "bits and pieces" from many 
places.



Compression Ratio
Compression ratio is a measure of how much Stacker compresses a file or set of files. If Stacker 
compresses a file to half its original size, that file's compression ratio is 2:1 ("two to one"). Many files have 
a compression ratio of 4:1 (one fourth the original size) or even better. When a drive's compression ratio 
is 2.5:1, it means that the data on the drive uses only 40 percent of the space it used before Stacker. 
Another way to look at it is that without Stacker on the drive, the data would occupy 2.5 times as much 
space.



Actual Compression Ratio
The comparison between a file's uncompressed size (without Stacker) and its compressed size (with 
Stacker). On the average, Stacker compresses files at a ratio of 2.5:1. Actual compression ratio is the rate 
at which your data is actually compressing. The actual compression ratio is indicated in the black-and-
yellow box of the Compression Ratio gauge in the Toolbox. Expected compression ratio is the rate at 
which Stacker assumed your data would compress during Stacker Setup.



Expected Compression Ratio
The rate at which Stacker expects data on your disk to compress. After compressing or recompressing a 
disk, Stacker adjusts the expected compression ratio. When it creates an empty Stacker drive, Stacker 
assumes future data will compress at about 2.5:1 so it makes your Stacker drive more than twice as big 
as before. On the Compression Ratio gauge, the expected compression ratio is the number in the upper 
left. If your actual compression ratio (in black and yellow) is significantly different from the expected 
compression ratio, you may want to recompress the drive so Stacker can adjust the value.

Normally, you don't have to worry about any discrepancy between these two ratios unless the disk is 
nearly full. Even then, recompressing the disk automatically adjusts the expected compression ratio for 
you.



Stacker Territory
The start of Stacker Territory is indicated by a red triangle on the Disk Space gauge. The area to the right 
is "Stacker Territory." This is the extra disk space Stacker provides to your system. Without Stacker, you 
would have only the space on the left side of the red triangle. The position of the red triangle is 
determined by the expected compression ratio. Normally, with a 2.5:1 expected compression ratio, the red 
triangle is to the left of the middle of the dial. The larger the expected compression ratio, the more to the 
left of center is the red triangle. If the expected compression ratio is exactly 2:1, Stacker Territory begins 
at the middle of the gauge.



Stackometer
An old name for the Stacker Windows Toolbox.



KB
Stands for kilobytes, a unit of computer storage. 1024 bytes = 1 KB; 1,024 KB = 1 MB (megabyte).



Recompress
Recompresses your data, maximizing the space available on your Stacker drive. Recompression always 
gets the best compression possible and resets your expected compression ratio. Used when upgrading 
from previous versions of Stacker to obtain the improved compression available with Stacker for Windows 
and DOS.



Compress
The process of reducing the space required to store data. As the data is stored, Stacker substitutes 
"tokens" for recurring byte sequences. The tokens take less space to store. Data is compressed when it is 
written to a Stacker drive. The Stacker Tuner controls the speed and tightness of compression. The 
settings range from MaxSpace to MaxSpeed. You can use the Tune tool from the Stacker Windows 
Toolbox to change these settings.



Decompress
The process of restoring data from its compressed form to its original uncompressed form. Stacker 
decompresses data when it is read from a Stacker drive.



Entire Drive
When Setup compresses the data on an entire drive, it compresses all the data currently on the disk into 
the Stacker drive. A few files may also remain on the uncompressed disk. After the data on an entire disk 
is compressed, it uses the same drive letter as the original disk.



Free Space
When Setup compresses only the free space, it creates an empty Stacker drive using space from the 
original disk. Any files originally on the disk remain in the uncompressed portion. The new empty Stacker 
drive has a new drive letter.



Hot Key
A hot key is a letter in the text label of each button and field that is underlined, highlighted, or in a different 
color. In most cases, pressing the hot key activates the button or field. If a text entry field is active, you 
have to hold down the ALT key while pressing the hot key.



STACVOL File
The hidden file on an uncompressed drive that actually contains all the compressed data. The STACVOL 
file is the Stacker drive.



Stacker Drive
The drive containing all the compressed data and compressed by Stacker 4.0 for Windows & DOS.



Removable Disk
A disk that can be removed from its drive and taken to another computer. Some removable disks are 
floppy disks, Bernoulli disks, and Syquest cartridges. When you compress a removable disk, you can 
store much more data on it. Stacker Anywhere lets other computers read from and write to the removable 
Stacker disk. 



Cache
An area in memory where data can be stored for quick access. The Stacker driver has a built-in cache big 
enough for at least one cluster and 9 KB for work areas. The cache portion of the driver can be stored in 
expanded or upper memory.



Cluster
A storage unit on a disk that is a fixed size for the disk. A typical Stacker cluster is 8 KB. Stacker can also 
use 4 KB, 16 KB, and 32 KB clusters.



Disk Space
The amount of space on the disk currently filled with data.



Pathname
The location of a file. A full path include the drive letter, a colon, and each directory. For example, the 
Stacker files are stored in the path C:\STACKER. If you have Windows on drive D, some files are stored 
in D:\WINDOWS\SYSTEM.



Path
The list of directories that DOS searches automatically to find an application. A PATH statement in the 
AUTOEXEC.BAT file generally establishes the path.



Stacker Tuner
Gives you the controls to fine-tune your Stacker drives. You set Stacker for maximum speed, maximum 
compression, or something in between. 



TSR
Terminate and Stay Resident. A memory resident program accessed while other programs are running.



AUTOEXEC.BAT
A special file automatically read at startup. Commands found within this file affect your system's 
configuration.



Boot Disk
The disk or drive your system starts up from.



DBLSPACE.BIN
The file that provides access to any preloaded data compression.



STACKER.INI
The file that contains configuration information for the Stacker device driver. 



Uncompressed Drive
The portion of your drive containing the large STACVOL file which is your Stacker drive. It may contain 
other files as well.



Preloading
A process used by recent DOS versions (such as MS-DOS 6, PC-DOS 6.1, and Novell DOS 7) that lets 
DOS recognize Stacker drives before reading CONFIG.SYS or AUTOEXEC.BAT.



Hidden File
A file that isn't normally listed when you type DIR. All files used for initially starting up the system are 
"hidden" so they can't accidentally be erased or edited. You can use DIR /AH to list these files if you want.



Stacker Device Driver
The software enabling Stacker's data compression. It remains in memory while your system is working.



Windows' Permanent Swap File
A permanent area on your hard disk that Windows can use as a "scratch pad," temporarily housing data 
during a Windows session. This file must remain uncompressed, but Stacker lets you store it on the 
Stacker drive if you prefer.



AutoMount
The process that lets Stacker automatically recognize external or replaceable drives as Stacker drives. 



Header
Each Stacker drive is made up of a header and a data area. The header includes all the information 
Stacker needs to access data from the Stacker drive. AutoSave saves copies of headers.



Replaceable Drives
Disk drives where the media can easily be physically replaced. Examples include floppy disks, 
Bernoullis™, and Syquest™ cartridges.



Stacker Optimizer
The Stacker program that produces more efficient storage of files on your disk. The Optimizer 
defragments and reorganizes files so they are stored in a contiguous area. That way, when you read a file 
from disk, DOS locates the file in one piece, instead of having to gather all the file's "bits and pieces" from 
many places



File Allocation Table (FAT)
The portion of your disk that contains all the information about the location of your files.



StartUp Group
A specific program group created by Windows. Whenever you start Windows, any applications found in 
the StartUp Group load immediately.




